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Preface
PREFACE

General 

Commissioning is the first step after the installation of the CIU 888. 
During commissioning, the CIU 888 site configuration is created and 
site elements such as field ports, tanks, GPU data inputs, Modbus data 
inputs, TRL/2 data input, and host ports are configured. 

When the site is in operation and there are changes, for example a 
gauge is added or an additional host system is connected, these 
changes need to be implemented, and the CIU 888 needs to be 
updated with the new site configuration.

Purpose of this manual

The purpose of this manual is to provide information about the 
commissioning and configuration of the CIU 888.

Target audience of this manual

This manual is primarily intended for service technicians who are 
responsible for commissioning and configuration of the CIU 888. For the 
migration of an existing CIU 880 Prime/Plus site configuration to the 
CIU 888, refer to the Ensite Pro to CIU 888 Migration Manual (Part No. 
4417593).
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Introduction
CHAPTER 1 INTRODUCTION 

The CIU 888 Service Tool is used for commissioning and configuration 
of the CIU 888. The CIU 888 Service Tool is typically installed on a PC/
laptop running Windows 7 or Windows 10, which in turn is connected to 
the CIU 888 via the Service port located at the front of the CIU 888

CIU 888 Service Tool replaces Ensite Pro as the configuration tool for 
CIU 888. The CIU 888 Service Tool provides the Ensite Pro 
configuration options with the following improvements:

 Support for a maximum of 80 tanks.

 Support for a maximum of 6 field ports.

 Support for a maximum of 6 host ports.

 Support for gauge engineering units.

 Support for configuring a maximum of 4 host ports for GPU 
emulation and Modsum Emulation

 Support for Modbus field scan.

 Support for Modbus TRL/2 field scan.

 Support for servicing of Rex gauges.

 Support for Modbus TCP/IP on host ethernet ports.

NOTE: CIU 888 Service Tool can be released independent of CIU 888 firmware, hence 
the CIU 888 Service Tool has its own release number independent of CIU 888 
firmware release number.

1.1 When to use CIU 888 Service Tool

From CIU 888 R103 release, CIU 888 Service Tool is being introduced 
to configure CIU 888. 

Until R103 release, Ensite Pro, Ensite Pro to CIU 888 Migration Tool, 
and Web interface are used during commissioning/configuration of the 
CIU 888. 

The Migration tool is used for uploading the site configuration to the CIU 
888 and for updating the INI files generated from Entis Pro. INI files are 
configuration files for Entis Pro. Migration tool needs to update the INI 
files before the files can be loaded to the Entis Pro tank inventory 
system.
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The applicable configuration tools and scenarios to configure CIU 888 
are mentioned in the following table.

Use Ensite Pro + Migration tool + Web 
interface

Use CIU 888 Service Tool

Supported scenarios: Supported scenarios:

NOTE: If an existing CIU 880 / CIU 888 needs to be migrated to the new CIU 888 
R130.1 release and adding the Modbus/TRL/2 field scan functionality, then CIU 
888 Service Tool should be used to define the configuration including the 
earlier configuration and the Modbus field scan configuration.

1.1.1 CIU888 and Service Tool Compatibility Matrix

1. Service Tool R101.1 is compatible with CIU 888 R103.1/R103.2

2. Service Tool R120.1 is compatible with CIU 888 R120.1

3. Service Tool R120.2 is compatible with CIU 888 R120.2

4. Service Tool R130.1 is compatible with CIU 888 R130.1

1.2 Recommended workflows to commission CIU 888

This section gives details on how to commission a CIU 888 (both 
redundant and non-redundant), and how to update the site configuration 
details of an existing CIU 888.

 CIU 880 being replaced by CIU 888, 
except 4 plus host ports in redundant 
non cross hot standby configuration.

 Earlier units of CIU 888 being 
replaced with new units of CIU 888.

 CIU 880 being replaced by CIU 888 
with 4 plus host ports in redundant 
non cross hot standby configuration 
(new configuration).

 New sites being commissioned for 
CIU 888.
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1.2.1 Commissioning a CIU 888 Standalone system
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Commissioning of a CIU 888 Standalone System Setup

Verify the license 
of CIU 888

1

2

 the site 
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FIGURE  1-1 Commissioning a Standalone System Setup

Notes: 1. Step 3 can be done offline without connection to CIU 888 and is 
independent of step 1 and 2. 

2. Steps 5 and 6 are required only when Entis Pro is a host connecting to 
CIU 888.
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1.2.2 Commissioning a CIU 888 Redundant system 
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Commissioning of a CIU 888 Redundant System Setup

Verify the license 
of primary CIU 888

1

2

 the site 

Service Tool

Send
the site 

to primary CIU 888

3 5

4 6

primary CIU 888 

the password

Generate  the 
INI FIles, start the

Seal the CIU 888,

completed

CIU 888
Service Tool

CIU 888 Service Tool 
to be installed on the 

C/Laptop

C/Laptop to be connected to 
primary CIU 888                 sin  ethernet  
cable via service port located at the 
front of CIU 888

Note: W&M lock key switch and 
the Con ra on lock key switch of  
 primary CIU 888 & secondary CIU 888    
m st be in ‘ nlocked’ posi on 

Commission
the secondary 

CIU 888

Verify the CIU 888

8

7

FIGURE  1-2 Commissioning of a Redundant System Setup

Notes: 1. Step 3 can be done offline without connection to CIU 888 and is 
independent of step 1 and 2.

2. Step 6 is required only when Entis Pro is a host connecting to CIU 888.
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1.2.3 Updating Non Redundant CIU 888 Configuration 

FIGURE  1-3 Updating Non redundant CIU 888 Configuration

NOTE: Steps 3 and 4 are required only when Entis Pro is a host connecting to 
CIU 888.
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1.2.4 Updating Redundant CIU 888s Configuration

FIGURE  1-4 Updating Redundant CIU 888s Configuration

Notes: 1. Steps 3 and 4 are required only when Entis Pro is a host connecting to 
CIU 888.

2. Primary CIU 888 & Secondary CIU 888 must be in sync.

3. Entis pro should be shut down before sending the site configuration to 
CIU 888.

4. Updates can be sent only to primary CIU 888 and not to secondary CIU 
888.
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Installing CIU 888 Service Tool
CHAPTER 2 INSTALLING CIU 888 SERVICE TOOL

2.1 Prerequisites

The PC/laptop must meet the following requirements to install the CIU 
888 Service Tool:

 Windows 7 Professional 64-bit or Windows 10 Enterprise 64 bit or 
Windows 10 LTSB 64 bit

 Microsoft .NET Framework 4.0 or higher

NOTE: Microsoft .NET Framework 4.0 is installed automatically during the installation 
of Windows 7 or Windows 10.

 Minimum 4 GB RAM

 Microsoft Internet Explorer 10.x or 11.x or Google Chrome (version 
43).
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2.2 Installing CIU 888 Service Tool

2.2.1 Installing CIU 888 Service Tool on the new machine

1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.

The License Agreement window appears:

3. Read all license agreement and select “ I accept the terms in the 
license agreement” .

4. Click Next.
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2 - 2 CIU 888



Installing CIU 888 Service Tool
The Ready to Install the Program window appears:

5. Click Install.

6. The Installing Honeywell CIU 888 Service Tool R130.1 installation 
progress status window appears:
Part No.: 4417584_Rev04 Configuration Manual
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7. The InstallShield Wizard Completed window appears after 
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will 
be added to the "Local Engineers" group.

8. Click Finish to close the wizard.

9. The message box appears to logoff and login the machine.

NOTE: If the local engineers group is already existing in the machine and if the current 
user is already associated with the local engineers group, the message box 
may not appear to logoff and login the machine.

10.Click Yes for installation changes to be effective.
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2.2.2 Upgrade the Installer

1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.

The License Agreement window appears:

3. Read all license agreement and select “ I accept the terms in the 
license agreement”.

4. Click Next.
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The Select Installation Option window appaers:

5. Select Upgrade the existing CIU 888 Service Tool to uninstall the 
previous version and install the new version.

The dialogue box appears to give message on the selected option.

6. Click Yes.

NOTE: This option removes the previous installation and then installs the new service 
tool.
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The Ready to Install the Program window appears:

7. Click Install.

8. The Installing Honeywell CIU 888 Service Tool R130.1 installation 
progress status window appears:
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9. The InstallShield Wizard Completed window appears after 
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will 
be added to the "Local Engineers" group.

10.Click Finish to close the wizard.

11.The message box appears to logoff and login to the machine..

NOTE: If the local engineers group is already existing in the machine and if the current 
user is already associated with the local engineers group, the message box 
may not appear to logoff and login the machine.

12.Click Yes for installation changes to be effective.
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2.2.3 Side by Side Installation

1. Right-click on Setup file and then click Run as administrator.

The welcome to installShield Wizard appears:.

2. Click Next.

The License Agreement window appears:

3. Read all license agreement and select “ I accept the terms in the 
license agreement”.

4. Click Next.
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The Select Installation Option window appears:

5. Select Install Honeywell CIU 888 Service Tool R130.1 to install the 
R130.1 version.

NOTE: This option installs the new version of CIU 888 Service Tool without interrupting 
older version. This is mainly designed to support multiple versions of CIU 888. 
Hence the user will be able to see two versions of CIU 888 Service Tool.

The Ready to Install the Program window appears:

6. Click Install.
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7. The Installing Honeywell CIU 888 Service Tool R130.1 installation 
progress status window appears:

8. The InstallShield Wizard Completed window appears after 
successfull installation:

NOTE: The "Local Engineers" group will be created by default and the current user will 
be added to the "Local Engineers" group.

9. Click Finish to close the wizard.
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10.The message box appears to logoff and login to the machine.

NOTE: If the local engineers group is already existing in the machine and if the current 
user is already associated with the local engineers group, the message box 
may not appear to logoff and login the machine.

11.Click Yes for installation changes to be effective.
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2.3 Post-Installation

It is recommended to disable fast user switching.

2.3.1 Add User’s to “Local Engineers” Window Group

CIU 888 Service Tool shall be launched only if the user is part of "Local 
Engineers" group. By default the installing user shall be added to this 
group.

Users needing access to CIU 888 Service Tool should be added to this 
windows group using "Manage Users and Groups" program of 
Windows.

2.3.2 Importing old site databases using CIU 888 Service Tool R130.1

From CIU 888 Service Tool R130.1, the site database is stored in the 
release specific location. Hence requires to import the old site database 
from its previous location, which in turn shall be stored in the specific 
location C:\Users\Public\Documents\Honeywell\CIU 888 Service Tool 
R130.1\SiteDatabase.
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2.4 CIU 888 Service Tool License

CIU 888 Service Tool license is generated based on the MAC address 
of the PC/Laptop where it will be used. To obtain a Service Tool license, 
you must send the MAC address and the general information of the PC/
Laptop (where the CIU 888 Service Tool is installed) to Enraf factory.

NOTE 1: This procedure would take a minimum of 2-3 days. Please plan for the same, 
so that you have the license ready before you begin the commissioning 
process.

NOTE 2: CIU 888 Service Tool R130.1 license has a new encryption algorithm. Hence 
CIU 888 Service Tool needs a new License to be requested. Existing machines 
which already have Service Tool R101.1 also need to request for the new 
license using the above mentioned procedure.

Once you have received the license file, complete these steps to install 
the license file.

1. Click  (Start) > All Programs > Honeywell > Configuration > 
CIU 888 Service Tool. The Browse For Folder window appears.

2. Browse to the license file received from the factory. Click OK.

3. CIU 888 Service Tool validates the license and starts the 
application.

NOTE: Once the license is validated, the same license file will be read automatically 
for subsequent usage.
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2.5 Uninstalling CIU 888 Service Tool

1. Click  (Start) > Control Panel > Programs > Programs and 
Features > Uninstall or change a program.

Select Honeywell CIU 888 Service Tool, right-click and choose
Uninstall.

2. A confirmation message appears.

Click Yes.
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Getting Started
CHAPTER 3 GETTING STARTED

The CIU 888 Service Tool is used for commissioning and configuring 
CIU 888. The CIU 888 Service Tool is typically installed on a PC/laptop 
running Windows 7 or Windows 10, which in turn is connected to the 
CIU 888 via the Service port located at the front of the CIU 888 (see 
FIGURE 3-1). 

FIGURE  3-1 CIU 888: Service port

FIGURE 3-2 shows a graphical overview of the CIU 888 Service Tool 
and the CIU 888. 

FIGURE  3-2 Graphic overview of the CIU 888 Service Tool and the CIU 888
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3.1 CIU 888 Web interface

The CIU 888 Web interface provides access to these functionalities:

 View the relevant W&M and non-W&M configuration settings of the 
CIU 888

 Display the system status, for example, the role of the CIU 888 in a 
redundant system setup, the status of the W&M lock key switch and 
the configuration lock key switch

 View system hardware diagnostics, for example, CIU 888 system 
status, Field port communication status, CIU version, and so on

 View audit and event records logged by CIU 888

 Install firmware upgrades

 Update the CIU 888 license

To view the CIU 888 web interface, it is recommended to have a PC 
screen resolution of 1280 x 1024 or higher.

The CIU 888 Web interface can be accessed using a standard browser, 
refer to section 2.1 for supported browsers.

3.1.1 Changing the settings of Internet Explorer

To access the CIU 888 using Internet Explorer 10 or 11, the following 
changes in the browser settings must be implemented:

1. Launch Internet Explorer.

2. Disable compatibility mode:

a) From the Tools menu, select the Compatibility View settings
option.
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The Compatibility View Settings window is displayed (see 
FIGURE 3-3). 

FIGURE  3-3 Compatibility View Settings window 

b) De-select (uncheck) all check boxes.

c) Click the Close button to close the window.

REMARK: Make sure you do not add the CIU 888 website to the compatibility view.

3. Add the CIU 888 website to the trusted sites.

a) From the Tools menu, select the Internet Options option.
The Internet Options window is displayed (see FIGURE 3-4). 
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b) Go to the Security tab. 

FIGURE  3-4 Internet Options window - Security tab

c) Click the Trusted Sites icon.

d) Click the Sites button.
The Trusted sites window is displayed (see FIGURE 3-5). 

FIGURE  3-5 Trusted sites window
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e) In the Add this website to the zone text box enter the IP address 
of the CIU 888 website (i.e. https://192.168.1.1). Next, click the 
Add button. 
The IP address of the CIU 888 is added to the trusted sites and is 
displayed under Websites (see FIGURE 3-6). 

FIGURE  3-6 Trusted sites window - CIU 888 website added to Trusted sites zone

f) Click the Close button to close the window.
You will go back to the Internet Options window.

g) Click OK to save the settings and to close the window.

4. Enable the “Initialize and script ActiveX controls not marked as safe 
for scripting” setting:

a) From the Tools menu, select the Internet Options option.
The Internet Options window is displayed (see FIGURE 3-4). 
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b) Go to the Security tab. 

FIGURE  3-7 Internet Options window - Security tab

c) Click the Trusted Sites icon.
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d) Click the Custom level... button.
The Security Settings - Trusted Sites Zone window is displayed 
(see FIGURE 3-8). 

FIGURE  3-8 Security Settings - Trusted Sites Zone window

e) Set the “Initialize and script ActiveX controls not marked as safe 
for scripting” to Enable.

f) Click the OK button to save the settings and to close the window.
You will go back to the Internet Options window.

g) Click the OK button to save the settings and to close the window.

5. Enable the “Include local directory path when uploading files to a 
server” setting:

a) From the Tools menu, select the Internet Options option.
The Internet Options window is displayed (see FIGURE 3-9). 
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b) Go to the Security tab. 

FIGURE  3-9 Internet Options window - Security tab

c) Click the Trusted Sites icon.
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d) Click the Custom level... button.
The Security Settings - Trusted Sites Zone window is displayed 
(see FIGURE 3-10). 

FIGURE  3-10 Security Settings - Trusted Sites Zone window

e) Set the “Include local directory path when uploading files to a 
server” to Enable.

f) Click the OK button to save the settings and to close the window.
You will go back to the Internet Options window.

g) Click the OK button to save the settings and to close the window.

6. Configure the self-signed SSL certificate.
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a) Enter the IP address of the CIU 888 (i.e. https://192.168.1.1) in 
the address bar of the browser. Press the Enter key.
The following warning message is displayed (see FIGURE 3-11). 

FIGURE  3-11 Website’s security certificate problem

b) Click the Continue to this website (not recommended) option.
You will go back to Microsoft Internet Explorer.

c) At the right of the address bar, click Certificate Error.
The Untrusted Certificate pop-up window is displayed (see 
FIGURE 3-12). 

FIGURE  3-12 Untrusted Certificate pop-up window
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d) Click View certificates.
The Certificate window is displayed. Verify the certificate details. 
(see FIGURE 3-13). 

FIGURE  3-13 Certificate window
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e) Click the Install Certificate... button.
The Certificate Import Wizard - Welcome window is displayed 
(see FIGURE 3-14). 

FIGURE  3-14 Certificate Import Wizard - Welcome window

f) Click the Next button.
The Certificate Import Wizard - Certificate Store window is 
displayed (see FIGURE 3-15). 

FIGURE  3-15 Certificate Import Wizard - Certificate Store window
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g) Select the Place all certificates in the following store radio 
button. Click the Browse... button.
The Select Certificate Store window is displayed (see FIGURE 3-
16). 

FIGURE  3-16 Select Certificate Store window

h) Select Trusted Root Certification Authorities. Next, click the 
OK button to save the settings and close the window.

i) Click Next.
The Certificate Import Wizard - Completing window is displayed 
(see FIGURE 3-17). 

FIGURE  3-17 Certificate Import Wizard - Completing window

j) Click Finish.
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REMARK: If a Security Warning message is displayed (see FIGURE 3-18), click Yes and 
then click OK. 

FIGURE  3-18 Security Warning message

k) From the Tools menu, select the Internet Options option.
The Internet Options window is displayed.
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l) Go to the Content tab. 

FIGURE  3-19 Internet Options window - Content tab

m)Click Certificates. 
The Certificates window is displayed.(see FIGURE 3-20). 
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n) Go to the Trusted Root Certification Authorities tab. 

FIGURE  3-20 Certificates window - Trusted Root Certification Authorities tab

o) Check if the CIU 888 website is listed.

p) Click Close to close the window.
You will go back to the Internet Options window.

q) Click OK to close the window.

r) Close (all instances of) Microsoft Internet Explorer.

s) Restart Microsoft Internet Explorer.

3.1.2 Changing the settings of Google Chrome

To access the CIU 888 using Google Chrome version 43, the following 
changes in the browser settings must be implemented:

1. Launch Google Chrome.

2. Configure the self-signed SSL certificate.
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a) Go to Settings > Show advanced settings > HTTPS/SSL and 
click Manage certificates... .

FIGURE  3-21 Navigate to the Manage certificates button on Google Chrome

b) In the ensuing Certificates window, click Import to launch the 
Certificate Import Wizard.

FIGURE  3-22 Certificates window: Import button
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c) Click Next on the Welcome screen.

FIGURE  3-23 Welcome screen

d) Click Browse and select the certificate file with a .p7b extension. 
You must select PKCS #7 certificates option to view the certificate 
file with the .p7b extension.

FIGURE  3-24 Browse to the certificate file

e) Click Next.

f) In the Certificate Store screen, select the Place all certificates in 
the following store option and click Browse.
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3 - 18 CIU 888



Getting Started
g) Click the Trusted Root Certification Authorities folder and click 
OK.

FIGURE  3-25 Select folder to save certificate file

h) Click Next. Details of the certificate file you are importing are 
displayed. Verify the details and click Finish.

FIGURE  3-26 Verify certificate details
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i) If a warning message appears, click Yes and continue.

FIGURE  3-27 Warning message

j) After the certificate is installed, a confirmation message appears. 
Click OK.

FIGURE  3-28 Confirmation message
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k) Click the Trusted Root Certification Authorities tab to verify 
that the certificate CIU 888 is added.

FIGURE  3-29 Verify installed certificate

3.1.3 To Allow Pop-ups for file download

Perform the following steps to allow pop-ups for file download:

1. Open the URL “chrome://settings/content/popups”.

2. Click on Allow > ADD.

3. Under Add a Site, enter the Site as https://192.168.1.1:443 (see 
FIGURE 3-31). 

FIGURE  3-30 Adding a Site window
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3.1.4 Launching the CIU 888 Web interface

Perform the following steps to launch the CIU 888 Web interface:

1. Launch a browser (refer to section 2.1 for supported browsers).

2. Enter the IP address of the CIU 888 in the address bar of the 
browser. The IP address is: 192.168.1.1. Press the Enter key.
The CIU 888 Login window is displayed (see FIGURE 3-31). 

FIGURE  3-31 CIU 888 Login window

3. Enter the username and password to log in to the CIU 888. The 
username is: ciuadmin. Click LOG IN.
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After entering a valid username and password, the CIU 888 Web 
interface is displayed (see FIGURE 3-32). 

FIGURE  3-32 CIU 888 Web interface
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3.2 Configuring a site using CIU 888 Service Tool

The first step in configuration of CIU 888 is the creation of a site using 
CIU 888 Service Tool. After a new site is created, the program prompts 
for a set of global settings. Global settings are the overall configuration 
settings applicable at a site level, see section 3.2.3 for more details. 
Global settings are required for initiating any site configuration.

After the site global settings are entered, CIU888 Service Tool prompts 
for CIU888 name and then CIU 888 Service Tool creates a site 
configuration.

A site gives an overview of the configuration at a specific customer’s 
site. The site configuration can be saved offline and opened at a later 
point in time. Selecting a site gives you access to its configuration. 
When the site is not available in the list, a new site must be created.

3.2.1 Preparation

Before you start configuring CIU 888, certain preparations are 
necessary. Make sure the following information is available:

 Site layout

 Field cabling information (which gauges are connected on the 
same pair of field wires, etc.)

 Tag names of field devices (gauges, CIU and tanks).

 Tank information (strapping tables, or tank capacity tables, roof 
details, etc.)

 Information on the types of stored product

 Host communication setup

 Modbus TCP/IP Communication set up

3.2.2 Launching CIU 888 Service Tool

1. Click  (Start) > All Programs > Honeywell > Configuration > 
CIU 888 Service Tool R130.1
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CIU 888 Service Tool is launched. The CIU 888 Service Tool screen 
is displayed (see FIGURE 3.1). 

FIGURE  3-33 CIU 888 Service Tool

3.2.3 Creating a new site

1. From the Honeywell CIU 888 Service Tool window, Choose File >
New.

The Create new site window appears.
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2. Type the Site name and click OK.

The Global Settings - CIU 888 Service Tool window appears.

You can view or set the measuring unit of the various parameters in the 
Global Settings dialog box.

Settings Units

Level dimension Select m, mm, ft, in, in/16, fis or in./256

Temperature dimension Select ˚C or ˚F

Density dimension Select kg/m3, ˚API, lbs/ft3, RD60 or lbs/US gal.

Pressure dimension Select kgf/cm2, Pa, kPa or psi (lbf/in2).

Flow dimension Select m3/min, m3/hr, l/min, l/hr bbls/min, bbls/hr, US 
gal/min, Us gal/hr or UK gal/hr.

Volume dimension Select l, m3, US gal or bbls.

Mass dimension Select kg, ton, US ton, lbs or long ton.

Std. ambient air pressure Enter ambient air pressure in kPa (default = 101.325 
kPa).

Air density Enter air density in kg/m3 (default = 1.226 kg/m3).

3. Click OK, after the global settings are updated/modified.

A warning message appears.
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4. Click Yes to continue.

The CIU 888 name window appears.

5. In the CIU 888 name box, type the name of the CIU 888 and click 
OK.

The CIU 888 Service Tool window appears.
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3.2.4 CIU 888 Node Properties/Settings

3.2.4.1 Modify CIU 888 Properties

1. Click CIU 888 node, by default, the CIU 888 tab appears displaying 
the properties..

You can view or edit these properties:

Properties Description

Priority agent Select Enable or Disable.
Refer to Appendix B.6 for more details.

CIU 888 Tag Name Displays CIU 888 name configured during 
site creation

Redundant state Select Primary or Non Redundant
This is the configured redundancy role of CIU 
888.

System decimal separator Select .(point) or ,(comma)
This indicates the decimal separator in which 
data would be presented to the user in CIU 
888 Service tool and CIU 888.

System thousand separator Select .(point), space or ,(comma)
This indicates the thousand separator in 
which data would be presented to the user in 
CIU 888 Service tool and CIU 888. 
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3.2.4.2 Modify Ambient Temperature Properties

1. Click the Ambient Temperature tab, the properties detail appears.

You can view or edit these properties:

Properties Description

Ambient temp. gauge address Enter ambient temperature transmission 
address.

Ambient temp. gauge TOI Select A, B, C, E or M*.

Ambient temp. gauge TOR Select C or ZAG*.

Ambient temp. scan enabled Check to enable ambient temperature scan.

* Refer to TABLE 3-1 for additional information.

Note: *Configure the Ambient Temperature settings only if ambient temperature is 
measured with a GPU gauge. If ambient temperature is measured with a Modbus 
gauge then configure it in Modbus Data input (refer to section 3.2.7.2).
If ambient temperature is measured with a TRL/2 gauge then configure it in TRL/2 
Data input (refer to section 3.2.7.3)

3.2.5 Configuring a Field port

1. On the CIU 888 node, right-click and choose Add > Field port/Host 
port.

2. The Add Site Element window appears.

3. In the Name box, type the name of the Field port and click OK.
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A field port node is created and displayed under CIU 888.

4. By default, the Field port tab appears.

You can view or edit these properties:

Properties Description

Protocol Type Select None, Modbus RTU (= RS-Communication), 
CIU-GPU (= RS-Communication), or BPM-GPU 
(= Honeywell Bi-Phase Mark) or Modbus TRL/2. See 
Note 1 and Note 2.

Field port option slot Select Option Slot 1, Option Slot 2, Option Slot 3, 
Option Slot 4, Option Slot 5, or Option Slot 6

Communication fail delay Enter a time between 0 and 255 seconds (default = 60). 
See Note 3.

Data fail delay Enter a time between 0 and 255 seconds (default = 60). 
See Note 4.

Poll strategy Select P, 1, 2, or 3.
See Note 5.

NOTE 1: BPM field card is used to interface with the Honeywell Enraf BPM field bus 
devices and RS-232C/RS485 field card is used to interface with the downlink 
CIU 880 / CIU 888 / CIU 858 and third party Modbus field devices. The TRL/2 
field card is used to interface with the Honeywell TRL/2 gauges and Rex 
gauges.

NOTE 2: If Protocol type is Modbus RTU / CIU-GPU, configure Field port tab and RS 
Field Port tab. If Protocol type is BPM-GPU, configure Field port tab and BPM 
Field Port. If Protocol type is Modbus TRL/2, configure Field port tab and TRL/
2 Field Port tab. 

NOTE 3: When a field communication fails it is possible to maintain last valid scan data 
in the CIU 888 database during a configurable amount of time. The 
communication fail delay mechanism is reset on the reception of data. 
For Example:
- modem delays bad cabling.
- no answer because of re-initializing gauge.
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NOTE 4: When a data fails it is possible to maintain the last valid scan data in the CIU 
888 database during a configurable amount of time. The data fail mechanism is 
reset on the reception of valid data. 
For Example:
- re-initialization of a gauge. 
- 802/811 digitizer failure.

NOTE 5: The setting in ‘Poll strategy’ determines the sequence in which the Field ports 
are scanned: 
PPPPPP = all ports scan parallel (= default).
P11111 = port 1 scans parallel, others scan sequentially.
112233 = ports 1 & 2, ports 3 & 4 and ports 5 & 6 scan in a separate sequence.

5. Click the BPM Field Port tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Baud rate Select 1200, 2400, or 4800. 

Turn around delay When CIU 888 receives a response from a field instru-
ment (in a field port) it waits for this time period before 
sending a new request on the same field port.
Enter time in ms (default = 20 ms).

Time out Enter timeout in ms (default = 250 ms).

Retries Enter number of retries in the range of 1 through 10 
(default = 3).

Sensitivity Enter sensitivity in the range of 1 through 7 (default = 
7).
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6. Click the RS Field Port tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description

Baud rate Select 1200, 2400, 4800, 9600, 19200, or 38400

Mode Select RS 232 or RS 485 (default = RS-232C).

Turn around delay Enter reply waiting time in ms (default = 20 ms).

Time-out Enter timeout in ms (default = 250 ms).

Note: For Modbus field ports, the default timeout of 250 
ms might not be sufficient in case of lower baud rates 
(1200, 2400 etc.,) and needs to be increased.
Calculate the field port timeout as Field port timeout = 
(1000 / baud rate) * No of bits in a byte * Maximum 
number of bytes retrieved from Modbus device in a 
single request ms and configure it accordingly.

Stop bits Select 1 or 2 (default = 1).

Parity Select Odd, Even, or None (default = Odd).

Duplex mode Select Full or Half (default = Full).

Retries Enter number of retries (default = 3)
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7. Click the TRL2 Field Port tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description

Baud rate Baud rate is fixed and not editable (default = 4800 ms).

Turn around delay Enter reply waiting time in ms (default = 20 ms).

Time-out Enter timeout in ms (default = 400ms).

Stop bits Stop bit is fixed and not editable (default = 1 at 
Parity= None).

Parity Select Odd, Even, or None (default = None).

Retries Enter number of retries (default = 3)

3.2.6 Configuring a Tank

1. After Field port is configured, you need to link the Tanks to the Field 
port.

2. On the Field Port 1 node, right-click and choose Add > Tank.

3. The Add Site Element window appears.

4. In the Name box, type the name of the Tank and click OK.
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5. The Tank1 node is created and displayed under Field port 1.

 
6. By default, the Tank tab appears.

You can view or edit these properties:

Properties Description

Tank name Name of the Tank

Tank available Check, if allowed

Tank Scan Select Enable or Disable

Level type Select Innage or Ullage/Outage

Shape Select the tank shape for this tank

0 = No shape defined, 
1 = Cylindrical fixed roof, 
2 = Cylindrical with floating roof, 
3 = Cylindrical with internal floater, 
4 = Spherical tank, 
5 = Bullet, 
6 = Underground bullet, 
7 = Irregular cavern

8...255: Reserved for future expansion by Honeywell
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7. Click the Product tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Product name Enter the product’s name.

GSV Calculation type Select GSV calc type. See available types in the table 
below.

Product code Select A, B, C, D or E if enabled for the selected GSV 
Calc
type.

Ref. temperature Enter local reference temperature if the text box is
enabled according to the table below.

TC Enter expansion factor in 10-7/˚C
(in case of product code ‘C’).

CTL (VCF) Enter volume correction factor.

TCF Enter temperature correction factor.
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‘

DCF Enter density correction factor.

S&W Enter sediment and water percentage.

Manual ref. density Enter the product’s reference density.

Mass calculation Select In vaccum or In air

Volume mass correction Select the volume mass correction:

None (no vapour mass) Default
S&W corr. (Liq. Mass from NSV; no Vap. Mass)
Vapour calc. Liq/Vol Ratio ISO/TC28/SC 3 N
Vapour calc. Molar Method ISO/TC28/SC 3 N
Vapour calc. Method API research proj.44
Vapour calc. Molar method ISO 6578

Air density Enter air density in kg/m3 (default = 1.226 kg/m3).

HIMS/HTMS not allowed Check to disable Hybrid Inventory Management Sys-
tem.

HTG Check to enable Hydrostatic Tank Gauging.

CTL A selection can be made between standard
calculations or rounding in 4 or 5 decimals.

GSV Calc Type Ref Temperature Product code

No GSV calc. Unchanged + disabled N.A. + disabled

DCF Unchanged + enabled N.A. + disabled

TCF Unchanged + enabled N.A. + disabled

Manual CTL Unchanged + enabled N.A. + disabled

ASTM-IP-52 23/24 60°F + disabled E + disabled

ASTM-IP-52 53/54 15°C + disabled E + disabled

D 1250-80 5/6 60°F + disabled A | B | C | D

D 1250-80 23/24 60°F + disabled A | B | C

D 1250-80 53/54 15°C + disabled A | B | C | D

D 1250-80 59/60 20°C + disabled A | B | C | D

D 1250-80 59/60 Alt T Unchanged + enabled A | B | C | D

D 1250-04 5/6 60°F + disabled A | B | C | D

D 1250-04 23/24 60°F + disabled A | B | C | D

D 1250-04 53/54 15°C + disabled A | B | C | D

D 1250-04 59/60 20°C + disabled A | B | C | D

D 1250-04 59/60 Alt T Unchanged + enabled A | B | C | D

TP-27-07 23/24 60°F + disabled E + disabled

TP-27-07 53/54 15°C + disabled E + disabled

TP-27-07 59/60 20°C + disabled E + disabled

Properties Description
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8. Click the Vapour tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Liq/Vol. ratio Enter liquid to volume ratio (default = 250).

Molar value Enter molar weight of gas composition (default = 0).

Vapour mass calculation

In air Select if applicable.

In vacuum Select if applicable.

TP-27-07 59/60 Alt T Unchanged + enabled E + disabled

D 4311-83 1 60°F + disabled N.A. + disabled

D 4311-83 2 15°C + disabled N.A. + disabled

D 4311-96 1 15°C + disabled N.A. + disabled

D 4311-04 1 15°C + disabled N.A. + disabled

D 4311-04 2 60°F + disabled N.A. + disabled

Chemical #100 Unchanged + enabled N.A. + disabled

Chemical #101 Unchanged + enabled N.A. + disabled

Chemical #102 Unchanged + enabled N.A. + disabled

Chemical #103 Unchanged + enabled N.A. + disabled

Chemical #104 Unchanged + enabled N.A. + disabled

Chemical #105 Unchanged + enabled N.A. + disabled

Chemical #106 Unchanged + enabled N.A. + disabled

Chemical #107 Unchanged + enabled N.A. + disabled

Chemical #108 Unchanged + enabled N.A. + disabled

Chemical #109 Unchanged + enabled N.A. + disabled

GSV Calc Type Ref Temperature Product code
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9. Click the Shell tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description

CTSh correction
(acc. API Chapter 12.1)

Check to enable tank shell expansion correction.

Tank shell calibrated 
(W&M)

Check to enable the option.

Tank shell exp. coeff Enter tank shell expansion coefficient.

Tank shell ref. tempera-
ture

Enter tank shell reference temperature.

Insulation factor Enter tank shell insulation factor. This can be a
figure between 0 and 1, in which 1 is for fully
insulated tanks.

10.Click the Flow tab, the Properties detail appears. 

You can view or edit these properties:

Properties Description

Moving detection
trip Level

Enter minimum trip level after which level increase/
decrease is indicated (default = 0).

Moving detection
interval

Enter interval time (in s) after which level increase/
decrease must be checked (default = 60 sec).

Flow calculation
Interval

Enter interval time (in s) after which volume increase/
decrease must be checked (default = 60 sec).
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11.Click the Roof tab, the Properties detail appears.

You can view or edit these properties:

Flow calculation
damping

Enter damping factor (0...1) for stable read-out
(default = 0.15).

Flow calculation indepen-
dent of moving status

Check to enable the option.

Properties Description

Zone enabled:

Zone 1 Enabled Check to enable the option.

Zone 2 Enabled Check to enable the option.

No GOV calculation:

Zone 1 No GOV calcula-
tion

Check to disable volume calculation when level is in 
zone 1.

Zone 2 No GOV calcula-
tion

Check to disable volume calculation when level is in 
zone 2.

No Water Volume calculation:

Zone 1 No Water 
Volume calculation

Check to disable the option.

Zone 2 No Water 
Volume calculation

Check to disable the option.

Properties Description
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NOTE: High/low zones: The program issues a warning if the low value is higher than 
the high value.

12.Click the Tank Capacity Table tab, the Properties detail appears. 

You can view or edit these properties:

Roof Weight:

Zone 1 Roof Weight Enter the weight of the tank roof.

Zone 2 Roof Weight Enter the weight of the tank roof.

High:

Zone 1 High Enter no-go-zone 1 high level.

Zone 2 High Enter no-go-zone 2 high level.

Low:

Zone 1 Low Enter no-go-zone 1 low level.

Zone 2 Low Enter no-go-zone 2 low level.

Properties Description

Water volume at no
water found

Enter water volume.

Shell capacity Enter shell capacity.

High level Enter level that corresponds with high TOV (for graphi-
cal purposes in Entis Pro).

Low level Enter level that corresponds with low TOV (for graphical
purposes in Entis Pro).

Note: The application checks the high level to be higher than the low level for 
innage. If the tank is set up for ullage the high level value must be lower than the low 
level value.

High TOV Enter volume that corresponds with high level (for 
graphical purposes in Entis Pro).

Properties Description
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13.On the Tank1 node, right-click and choose Add Tank Capacity 
Table.

 

The following window appears.

 
You can add a new Tank Capacity Table or view an existing one.

Properties Description

Tank Capacity Table Refer to Appendix D for the format of Tank Capacity 
Table.

Browse Click ‘Browse’ to select a tank capacity table. Selected 
file is copied to the data environment of the selected 
site (C:\Users\Public\Documents\Honeywell\CIU 888 
Service Tool\SiteDatabase\<sitename>\STR. 
The copied file gets the name [Tank name].txt.

View Click ‘View’ to view the tank capacity table.

Note: A selected tank capacity table file is only accepted if the used engineering
units match the global selected engineering units of the site configuration.

Low TOV Enter volume that corresponds with low level (for graph-
ical purposes in Entis Pro)

Note: The application checks the high TOV to be higher than the low TOV for 
innage. If the tank is set up for ullage the high TOV value must be lower than the low 
TOV.

Properties Description
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3.2.7 Configuring a GPU Data Input or Modbus Data Input or TRL/2 Data Input

After Tanks are linked to the applicable Field ports, you should add 
either GPU Data Input or Modbus Data Input or TRL/2 Data Input to the 
respective Tanks.

3.2.7.1 GPU Data Input

1. On the Tank1 node, right-click and choose Add > GPU Data Input.

2. The Add Site Element window appears.

3. In the Name box, type the name of the GPU Data Input and click OK.
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4. The G1 node is created and displayed under Tank1.

 
5. By default, the Gauge tab appears.

You can view or edit these properties:

Properties Description

Data Input Name You can see the name of the GPU Data Input

Gauge Detail Select ‘h’ for 854 gauges using the ZLQ record (up to 
software version SPUA1.0) or select ‘-‘ for 854 gauges 
(with software version SPUA2.0 onwards).

Gauge Type Select Unknown, 811, 854, 866, 872, 873, 877, 894, 
970, 971, 973, or 990.

Allow Interface 2 com-
mand

Check the option, if allowed (I2; 854, 894 only).

Allow Block gauge Check the option, if allowed (BL; 811, 854, 894 only).

Allow Tank profile Check the option, if allowed (TP; 854, 894 only).

Allow Gauge alarm test Check the option, if allowed (AT; 873 only).

Allow Lock test Check the option, if allowed (LT; 811, 854, 894 only).

Allow Reset gauge Check the option, if allowed (RS).

Allow Test gauge Check the option, if allowed (TG; 811, 854, 894 only).

Allow Verify command Check the option, if allowed (CA; 854, 894 only).

Allow Water dip Check the option, if allowed (I3; 811, 854, 894 only).

Allow Interface profile Check the option, if allowed (IP; 854, 894 only).
Part No.: 4417584_Rev04 Configuration Manual
CIU 888 3 - 43



Getting Started
6. Click the Level tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Level enabled Check to enable level scan.

0.1 mm level resolution Check to enable the option. This selection is only possi-
ble if the level engineering unit is set to ‘m’ or ‘mm’ and 
if the gauge type is not 811, 813, 866 or 872.

Negative levels enabled Check to enable the option. This selection is only possi-
ble for gauge types 854, 872, 873 and 894

No alarm when gauge in 
test

Check to disable gauge alarms during operational com-
mands.

Level address Enter level transmission address.

Level TOI Select B, C, E, or M*.

Level TOR Select B, ZLQ or L (the combination of level TOR
‘ZLQ’ and level type ‘Ullage’ is not possible. With level 
type ‘Ullage’, use level TOR ‘L’)*.

* Refer to TABLE 3-1 for additional information.

7. Click the Water tab, the Properties detail appears.
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You can view or edit these properties:

Properties Description

Water probe enabled Check to enable water level scan from external probe.

Water dip enabled Check to enable water level scan from servo gauge.

Water dip offset Enter water level offset.

Minimum. water level Enter minimum water level. This value is used when
no water level is found.

Water address Enter water level transmission address.

Water TOI Select B, C, E, or M*.

Water TOR Select M, J, B, L or ZLQ

Water in foreground scan Check to enable the option.

* Refer to TABLE 3-1 for additional information.

8. Click the Temperature tab, the Properties detail appears.

 

You can view or edit these properties:

Properties Description

Temperature enabled Check to enable product temperature scan.

Element type Select No element available, MRT, MRT with bottom
spot, MRT with bottom and top spot, One spot
element, Two spot element or MTT.

Lowest element 
Position

Enter lowest temperature element position.

Temperature address Enter product temperature transmission address.

Temperature TOI Select: B, C, E, or M*.

Temperature TOR Select: C or ZAG*.

Temperature in fore-
ground scan

Check to enable the option.

* Refer to TABLE 3-1 for additional information.
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9. Click the Density tab, the Properties detail appears.

 
You can view or edit these properties:

Properties Description

HIMS (HTMS) enabled Check to enable density scan from HIMS
configuration.

Density dip enabled Check to enable density scan from servo gauge.

Min. dip level Enter minimum density level.

Density address Enter density transmission address.

Density TOI Select: B, C, or E*.

Density TOR Select: ZQQ*.

Density in foreground
scan

Check to enable the option.

* Refer to TABLE 3-1 for additional information.

10.Click the Pressure tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Vapour temp & pressure Check to enable vapour pressure scan.

Pressure Type:

Absolute pressure Select if applicable.
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11.Click the Vapour tab, the Properties detail appears.

 
You can view or edit these properties:

Properties Description

Vapour temp. & pressure 
enabled

Check to enable Vapour temp. & pressure scan

Vapour temp. address Enter vapour pressure transmission address.

Vapour temp. TOI Select the Type of Instrument: B, C, E, or M*.

Vapour temp. TOR Select the Type of Record for the Vapour Temperature 
measurement: C or ZAG*.

Vapour temp. in 
foreground scan

Check to enable the Vapour temp. in 
foreground scan.

* Refer to TABLE 3-1 for additional information.

Relative pressure Select if applicable.

Pressure address Enter vapour pressure transmission address.

Pressure TOI Select: B, C, E, or M*.

Pressure TOR Select: ZP3*.

Pressure in foreground
scan

Check to enable the Pressure in foreground
scan.

* Refer to TABLE 3-1 for additional information.

Properties Description
Part No.: 4417584_Rev04 Configuration Manual
CIU 888 3 - 47



Getting Started
12.Click the Units of Measurement tab, the Properties detail appears.

You can view or edit these properties:

Properties Description

Level Select m, mm, ft, in, in/16, fis, or 1/256 in.

Temperature Select °C or °F

Vapour Pressure Select kgf/cm2, Pa, kPa, psi, psi_r100, or psi_r1000

Water Select m, mm, ft, in, in/16, fis, or 1/256 in.

Density Select kg/m3, °API, lbs/ft3, RD60, or lbs/US gal.

Vapour Temperature Select °C or °F

NOTE: Make sure that Gauge Units of Measurement matches with the Units of 
Measurement configured in the gauge. Default gauge Units of Measurement 
are based on the configured global Units of Measurement.

TABLE  3-1 Special Characters

Special Characters Description

TOI A = 802/812 gauge.

B = 811 gauge with GPU protocol and devices with 
gauge type=B.

C = 813 MGT and devices with gauge type=C.

E = 811 gauge with external alarms and devices with 
gauge type=E.

M = 816 /818.
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3.2.7.2 Modbus Data Input

1. On the CIU 888 node, right-click and choose Import MODBUS 
device type file.

NOTE: Modbus device configuration file for Honeywell Smartline level transmitter 
SLG700 is available by default in the CIU 888 Service tool. For new field 
device, import its Modbus device configuration file to the CIU 888 Service tool.

TOR B = Alarm status + [contact status] if TOI is C or E + 
product level.

C = Alarm status + [contact status] if TOI is C or E + 
temperature.

J = Alarm status + water level.

L = Alarm status + [contact status] if TOI is C or E + 
signed level.

M = Water alarm status + [contact status] if TOI is C or E 
+ water level status + water level record.

ZAG = Average vapour temperature (854, 873, 877, 
970, 971 & 973 only).

ZLQ = Innage servo level (854 only).

ZQQ = Abbreviated hydrostatic density (854, 866, 873, 
877, 970, 971 & 973 only).

ZP3 = Pressure sensor P3 (854, 866, 873, 877, 970, 
971 & 973 only).

Special Characters Description
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2. Device Type- CIU 888 Service Tool window appears.

3. Select the XML of the Modbus device and click Open.

The details of the specified XML file are loaded.

Refer to Appendix E for the creation of a new Modbus field device 
configuration file.

4. On the Tank node, right-click and choose Add > Modbus Data 
Input.

5. The Add Site Element window appears.

6. In the Name box, type the name of the Modbus Data Input and click 
OK.
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7. The M1 node is created and displayed under Tank1

You can view or edit these properties.

Properties Description

DeviceGPUAddress This indicates the GPU address of the Honeywell TRL2 
field device.

CIU Parameter This indicates the CIU parameter name to which the 
scanned Modbus field device parameter has to be 
mapped. CIU Service tool displays all the CIU Parame-
ters which can be scanned from Modbus field devices in 
a drop down menu.

Device Type This is the Modbus field device type. For example, this 
can be Smartline Level Transmitter, E+H ProServo. CIU 
Service tool displays all the supported device types in a 
drop down menu.

Device Slave ID Each Modbus device is addressed with a unique slave 
ID. That is, when a request is received by a Modbus 
device, it checks the Modbus slave ID in the request 
and if it matches with its configured slave ID, it 
responds back, else it skips the request. This indicates 
the Modbus RTU address of the field device.

Device Modbus Start 
Address

This parameter indicates the address from where the 
Modbus mapping starts for a device. In case of Modbus 
field devices that are directly connected to CIU this 
could be 0 and in case of Modbus data concentrator, 
the user has to configure it based on the device number 
in the Modbus data concentrator. For example, for E+H 
ProServo Modbus field device, this value could be 0 
and for Smartline Level Transmitter connected as sec-
ond HART device to a HCS Modbus-HART converter, 
this value could be 264.
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3.2.7.3 TRL/2 Data Input

1. On the CIU 888 node, right-click and choose Import TRL/2 device 
type file.

NOTE: TRL2 device configuration file for Honeywell Radar TRL2 gauge, Rex RTG 
gauge, SDAU2100, Honeywell VITO are available by default in the CIU 888 

Device Parameter Name This indicates the name of the parameter in the Modbus 
field device which needs to be scanned by CIU. This 
parameter would be used by CIU to interpret data in 
case of custom value mapping.

Modbus Register 
Address

This indicates the relative Modbus address of the 
selected parameter.
Absolute Modbus address of Parameter = Device Mod-
bus Start Address + Modbus Register Address

Scan Priority This indicates the scanning priority for a device parame-
ter. This can be configured as Foreground / Back-
ground. While scanning the field device, if multiple field 
device parameters are retrieved in one Modbus 
request, then highest priority within the scanned field 
device parameters is set for that request. 
For example, if Product Level (Foreground priority), 
Product Temperature (Background priority), Product 
Density (Background priority) are retrieved from the 
field device with a single Modbus request, then the 
Modbus request would be scheduled to the field with 
Foreground priority.

Device Engineering Unit This indicates the unit in which data is exposed by the 
Modbus field device. For example, E+H ProServo Mod-
bus field device can expose "Liquid Level" parameter in 
5 different units (mm, cm, m, ft, inch) and the user has 
to select the appropriate device unit based on the Mod-
bus field device configuration.

Properties Description
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Service tool. For new field device, import its TRL2 device configuration file to 
the CIU 888 Service tool.

2. Device Type- CIU 888 Service Tool window appears.

3. Select the XML of the TRL/2 device and click Open.

The details of the specified XML file are loaded.

Refer to Appendix E for the creation of a new TRL/2 field device 
configuration file.
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4. On the Tank node, right-click and choose Add > TRL/2 Data Input.

5. The Add Site Element window appears.

6. In the Name box, type the name of the TRL/2 Data Input and click 
OK.
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7. The G1 node is created and displayed under Tank T1.

You can view or edit these properties.

Properties Description

DensityCalculationType This parameter indicates the HIMS density calculation 
type.

P1SensorPosition The position of the center of the Liquid Pressure sensor 
membrane. This is expressed in m.

P3SensorPosition The position of the center of the Vapor Pressure sensor 
membrane. This is expressed in m.

HybridMinLevel This value specifies the lowest product level at which 
the Observed Density would be calculated.

CIU Parameter This indicates the CIU parameter name to which the 
scanned TRL/2 field device parameter has to be 
mapped. CIU Service tool displays all the CIU Parame-
ters which can be scanned from TRL/2 field devices in a 
drop down menu.

Device Type This is the TRL/2 field device type. For example, 
Emersion Rex, Honeywell TRL/2 Gauge. CIU Service 
tool displays all the supported device types in a drop 
down menu.

Device Slave ID Each TRL/2 device is addressed with a unique slave ID. 
That is, when a request is received by a Modbus 
device, it checks the TRL/2 slave ID in the request and 
if it matches with its configured slave ID, it responds 
back, else it skips the request. This indicates the TRL/2 
RTU address of the field device.
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Device GPU Address This indicates the GPU address of the Honeywell TRL2 
field device.

Device Flexconn Address This indicates the Flexconn address of the Honeywell 
TRL2 field device.

Device Modbus Start 
Address

This parameter indicates the address from where the 
TRL/2 mapping starts for a device. In case of TRL/2 
field devices that are directly connected to CIU this 
could be 0 and in case of TRL/2 data concentrator, the 
user has to configure it based on the device number in 
the TRL/2 data concentrator. For example, TRL/2 data 
concentrators.

Device Parameter Name This indicates the name of the parameter in the TRL/2 
field device which needs to be scanned by CIU. This 
parameter would be used by CIU to interpret data in 
case of custom value mapping.

Modbus Register 
Address

This indicates the relative TRL/2 address of the 
selected parameter.
Absolute TRL/2 address of Parameter = Device TRL/2 
Start Address + TRL/2 Register Address

Scan Priority This indicates the scanning priority for a device parame-
ter. This can be configured as Foreground / Back-
ground. While scanning the field device, if multiple field 
device parameters are retrieved in one TRL/2 request, 
then highest priority within the scanned field device 
parameters is set for that request. 
For example, if Product Level (Foreground priority), 
Product Temperature (Background priority), Product 
Density (Background priority) are retrieved from the 
field device with a single TRL/2 request, then the TRL/2 
request would be scheduled to the field with Fore-
ground priority.

Device Engineering Unit This indicates the unit in which data is exposed by the 
TRL/2 field device. For example, E+H ProServo TRL/2 
field device can expose "Liquid Level" parameter in dif-
ferent units (example: mm, cm, m, ft, inch) and the user 
has to select the appropriate device unit based on the 
TRL/2 field device configuration.

Properties Description
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3.2.8 Configuring a Host port

1. On the CIU 888 node, click Host port 1.

2. By default, the Host port tab appears.

You can view or edit these properties:

Properties Description

Device Name Two serial host ports are available by default and 
device name is fixed for them. For new Host ports 
created, the user has to select appropriate option slot.

Host Port Configuration 
name

It is a user friendly configuration name.

Physical Layer Select RS-232C or RS-485 (default = RS-232C).
Note: If ‘RS-232C’ is selected, while in reality RS-485 
hardware is applied, communication cannot be 
established.

Baud rate Select 1200, 2400, 4800, 9600, 19200 or 38400 (default 
= 19200).

Data bits Select 7 or 8 (default = 8).

Stop bits Select 1 or 2 (default = 1).

Parity Select Odd, Even, or None (default = Odd).

Duplex mode Select Full or Half (default = Full).

Turn around delay Enter reply waiting time in ms (default = 20 ms).

RTU address Enter the RTU address in the range 1 through 247 
(default= 41).
Note: Each RTU address must be unique in the site.
Part No.: 4417584_Rev04 Configuration Manual
CIU 888 3 - 57



Getting Started
Protocol Type Select None, Modbus RTU, or CIU-GPU (default = 
None).
Modbus RTU shall be selected if data needs to be 
presented to Modbus Hosts like Entis Pro, PLC etc and 
service tool like Tank master Winsetup connects to 
CIU888.
CIU-GPU shall be selected if data needs to be 
presented to GPU clients like Entis XL, profiling tools 
like Entemp etc., In this case, the host port would be 
configured for CIU Emulation.

Modbus Mode When host port is configured for Modbus RTU protocol, 
Modbus Mode property indicates the operation mode 
for the host port.
Note: Refer to the Protocol Manual - CIU Emulation CIU 
888 (Part No. 4417589) section 3.1.2, for more informa-
tion.

Modbus Mapping Select Entis Pro compliant, User specified, or CIU Plus 
compliant.
Entis Pro compliant shall be selected if Entis Pro is con-
nected to this port. All data will be filled in predefined 
positions.
CIU Plus compliant shall be selected if CIU Plus is con-
nected to this port. All data will be filled in predefined 
positions.
Note: Refer to Protocol Manual - Modbus Host (Part No. 
4417588) section 2.4, Input registers and Holding regis-
ters, for more information.
User specified shall be selected if a Modbus host like 
DCS, PLC is connected to this port. Refer to 
section 3.2.9 ‘Modbus settings’ for details how to con-
figure the Modbus map.

Absolute start address Enter start address for the User data area of CIU 888 
Modbus map (default = 0).
For Example: Change the start address to 10000 if 80 
tanks need to be supported with Entis pro compliant 
modbus map.

Suppress moving status This configuration indicates whether moving status is 
suppressed (or) not in the CIU 888’s Modbus Tank 
record.

MSU mode Check to enable the option.
MSU mode is mainly for CIU emulation and is applica-
ble only when the protocol type is CIU-GPU. 
Note: Refer to the Protocol Manual - CIU Emulation CIU 
888 (Part No. 4417589) for more information.

Host port GPU cache Check to enable the option.
When GPU cache mode is enabled, the CIU 888 gets 
the data from cache (if available) and responds to GPU 
host request.

Properties Description
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3. Click the Secondary CIU Host tab, the Properties detail appears.

You can view or edit these properties.

Properties Description

Secondary RTU address Enter the RTU address in the range 1 through 247 
(default= 43).
This is the secondary CIU's Host port RTU address.
Note: Each RTU address must be unique in the site.

3.2.9 Configuring User defined Modbus map 

The CIU 888 provides data in the Modbus area of the host ports for 
consumption by external hosts. The Modbus mapping of ports not in 
use by the Entis Pro system can be modified to become compliant with 
third party Modbus hosts as described below.

1. Click Host port 1 and change Modbus mapping as User specified.

2. Configure the absolute start address to the start of user defined 
modbus area.

3. Click Apply.
Part No.: 4417584_Rev04 Configuration Manual
CIU 888 3 - 59



Getting Started
A pop up window appears, Click OK.

4. On the Host port 1 node, right-click and choose User defined 
modbus map.

User defined modbus map window appears.

3.2.9.1 User defined modbus map - Tanks

The configuration settings in this tab will define the layout of modbus 
data and sequence of the tanks in the modbus map.
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You can view or edit these properties.

Properties Description

Data Orientation Select Tank oriented (= data grouped by tank) or Data 
oriented (= data grouped by entity).

Record interval Enter the number of registers allocated for each tank 
record
(default = 125).

Always force data output 
to fail value if validity is 
failure

Select to force the Modbus registers to invalid data, if 
the status/validity of the parameter indicates failure. If 
not selected, the last known value will be retained in the 
Modbus registers.

Available Tanks This displays all tanks that are not associated in the 
modbus map.

 Click this button to move all the tanks from ‘Available 
Tanks’ to ‘Selected Tanks’.

Click this button to move all the tanks from ‘Selected 
Tanks’ to the ‘Available Tanks’.

Click this button to move the selected tank from 
‘Available Tanks’ to ‘Selected Tanks’.

Click this button to move the selected tank from 
‘Selected Tanks’ to ‘Available Tanks’.

Click this button to move the selected tank in the 
‘Selected Tanks’ one position up.

Click this button to move the selected tank in the 
‘Selected Tanks’ one position down.

Click this button to move all the tanks to ‘Selected 
Tanks’ in the creation order.

Selected Tanks This displays tanks that are associated in the modbus 
map.
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3.2.9.2 User defined modbus map - Entities

NOTE: The selected list of entities is shown on the right part of the entities tab, this is 
referred as ‘Selected entities’ in the below description.

You can view or edit these properties.

Properties Description

Available Entities This displays all entities which are not associated with 
modbus map.

NOTE:This includes the list of entities provided by CIU 
880 Prime and CIU 880 Plus user defined host port 
Modbus mapping and also new entities added in 
CIU888.

Click this button to move all entities in the ‘Available 
entities’ to the ‘Selected entities’

Click this button to move all entities in the ‘Selected 
entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Available entities’ to the ‘Selected entities’.

Click this button to move the selected entity in the 
‘Selected entities’ to the ‘Available Entities’.

Click this button to move the selected entity in the 
‘Selected entities’ one position up.

. Click this button to move the selected entity in the 
‘Selected entities’ one position down.
Configuration Manual Part No.: 4417584_Rev04
3 - 62 CIU 888



Getting Started
3.2.10 Configuring Ethernet Host port

3.2.10.1 Configuring FTEA and FTEB ports

1. On the CIU 888 node, click FTEA port.

2. By default, FTE tab appears displaying various properties.

You can view or edit these properties.

Click this button to select ‘Entis Pro’ compliant entities 
in 'Selected entities'.

Definitions

Entity ID Entity ID number

Entity Name Name of the Entity

Type Modbus data type of the entity.

Size Number of Modbus registers

Scale Scaling factor

Offset Offset value

Parameters Configuration options

Device name This indicates the device name of the Ethernet port. 

IP Address IP address of the corresponding Ethernet port in the 
CIU.

Format: a.b.c.d
Example: 10.70.100.101 

Properties Description
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Subnet Mask Subnet mask of the corresponding Ethernet port in the 
CIU. In case of redundant CIUs, this also indicates the 
Subnet mask of the corresponding Ethernet port in the 
partner CIU.

Format: e.f.g.h
Example: 255.255.255.0

Default Gateway Default Gateway of the corresponding Ethernet port in 
the CIU. In case of redundant CIUs, this also indicates 
the default gateway of the corresponding Ethernet port 
in the partner CIU.

Format: i.j.k.l
Example: 10.79.100.1

Note: If no gateway is required, then this setting can be 
left blank.

Modbus Server Enable This indicates enable / disable of the Modbus TCP 
Server on the Ethernet port. That is, based on the need 
the user shall enable / disable Modbus TCP/IP server 
on a particular Ethernet port.

Modbus Port Number This indicates the software port number in which Mod-
bus server would be enabled. The default port number 
is 502.

Modbus Server Protocol 
Type

This indicates the Modbus server protocol type.
Supported protocols are
Modbus TCP/IP

Parameters Configuration options
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Transparency/Non-Trans-
parency mode

Transparency mode: When the check box is selected, 
it is said to be in Transparency mode.This indicates 
transparency behavior of the Ethernet port. This setting 
is applicable only to the redundant CIUs.
In this mode, CIU binds the IP address to Ethernet port 
based on the current redundancy role.

� Primary CIU binds to its IP address during active or 
passive state when all the Ethernet links (marked 
for IP Switch over decision maker) of the Secondary 
CIU is down.

� Primary CIU binds to Secondary CIU's IP address 
during passive state when atleast one of the 
Ethernet links (marked for IP Switch over decision 
maker) of the Secondary CIU is up.

� Secondary CIU binds to its IP address during 
passive state when atleast one of the Ethernet links 
(marked for IP Switch over decision maker) of the 
Primary CIU is up.

� Secondary CIU binds to Primary CIU's IP address 
during active or passive state when all the Ethernet 
links (marked for IP Switch over decision maker) of 
the Primary CIU is down.

Non-Transparency mode: When the check box is not 
selected, it is said to be in Non-Transparency mode.In 
this mode, Primary CIU binds to its IP address and Sec-
ondary CIU binds to its IP address irrespective of the 
redundancy role. 

Parameters Configuration options
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IP switch over decision 
Maker 

This option is applicable only for redundant CIUs and is 
required for the host initiated switchovers to work prop-
erly since CIU doesn't support autonomous switchovers 
This indicates whether Active CIU's Ethernet port status 
is monitored by the Passive CIU to make IP switchover 
decision.

If all the ports selected for "IP Switchover Decision 
Maker" in Active CIU goes down (that means the Mod-
bus TCP/IP Host system cannot communicate to active 
CIU), then Passive CIU's Ethernet port's bind to Pri-
mary CIU's Ethernet port address.

In case of Multiple host systems connected to CIU, we 
need to select this option for the Ethernet ports where 
the master host system (that can read, write data to 
CIU and issue switchover command) is connected. 

For example a site has ExperionPKS connected to 
FTEA and FTEB ports and a third party Modbus TCP/IP 
host system connected to LAN port and ExperionPKS 
is the master host system (Issues switchover command 
to CIU). In this case, FTEA and FTEB ports need to 
selected for "IP Switchover Decision Maker" and LAN 
port is deselected for "IP Switchover Decision Maker". 
In this case, if both FTEA and FTEB links of Active CIU 
goes down, then Passive CIU's FTEA and FTEB ports 
bind to the Primary CIU's IP address so that Host Sys-
tem (ExperionPKS) can issue an ACTIVE CIU com-
mand and make the CIU as Active and continue its 
operations.

Modbus Server Idle time-
out (s)

This indicates the idle time period (no Modbus mes-
sage exchanges) in seconds after which a client con-
nection would be closed by the Modbus TCP/IP server.
Value is from 10 to 65535. Default is 60.

IP Address Filter This enables / disables IP address filtering by the Mod-
bus TCP/IP server.  If enabled, Modbus TCP/IP server 
only accepts connections from the IP addresses / range 
configured in "IP addresses / Range" option.

Parameters Configuration options
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3. Click the Secondary FTE Host Port tab to view the Property.

 

Allowed IP Addresses / 
Range

This indicates the IP address list (IP addresses / range) 
from which connection is accepted by the Modbus TCP 
server. Client connections from any other IP addresses 
apart from that configured here would be rejected by 
the Modbus TCP/IP server.
The user shall be able to configure multiple IP 
addresses / ranges.
IP addresses Format: IP addresses separated by 
comma. 

Example: 10.70.50.3,10.70.50.5,10.70.50.10
IP address ranges Format: IP address range is speci-
fied with "-" and multiple IP address ranges are sepa-
rated by comma.
Example: 10.70.50.3-10.70.50.7,10.70.50.100-
10.70.50.105

Unit Id Filtering This enables / disables Unit Id (Unit identifier) filtering 
by the Modbus TCP/IP server. If enabled, Modbus 
TCP/IP server only responds to Modbus requests with 
Unit Id (Unit Identifier) from the Unit Id list configured in 
"Unit Ids" option.

Allowed Unit IDs This indicates the Unit Id (Unit Identifier) list for which 
Modbus TCP/IP server should respond. Modbus 
requests with any other Unit Id apart from that config-
ured here would be ignored and not responded by the 
Modbus TCP/IP server.

Example: 1,2,3,4,5
Multiple Unit IDs are separated by commas.

Parameters Configuration options
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You can view or edit this property.

Parameter Configuration option

Secondary IP Address In case of redundant CIUs, this indicates the IP address 
of the corresponding Ethernet port in the partner CIU. 
CIU Service tool shall have a provision to get the same 
from user. 

Format: w.x.y.z
Example: 10.70.100.102

NOTES: 1. If configuring for Experion network, both FTE A and FTEB should be in 
same subnet. 

2. If configuring in non-redundancy mode, then Transparency and IP 
switchover decision maker should be disabled. 

3.2.10.2 Configuring LAN ports

1. On the CIU 888 node, click LAN port.

2. By default, LAN tab appears displaying various Properties.

 

You can view or edit these properties. 

Refer to the parameters and configuration options in FTE tab under 
FTE A port given in section 3.2.10.1 for more information.

3. Click the Secondary FTE Host Port tab to view the Property.

Refer to the parameters and configuration option in Secondary FTE 
Host Port tab under FTE A port given in section 3.2.10.1 for more 
information.

NOTES: 1. In Experion PKS integration via FTE network, FTE A and FTE B should be 
in same subnet and LAN should be in different subnet.
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2. In other host system integration, FTE A, FTE B and LAN should be in 
different subnets.

3.2.11 Configuring Modbus map for TCP/IP ports

CIU 888 node provides the option to create, edit and delete TCP/IP 
modbus maps. 

3.2.11.1 Create TCP/IP Modbus Map

1. On the CIU 888 node, right-click and select Create TCP/IP modbus 
map from the menu.

2. The New TCP/IP Modbus Map window appears.

3. The two fields seen in the window and a brief description of each of 
them are as follows:

 Modbus Configuration Name - This indicates the Modbus 
configuration name. This shall be used to identify a Modbus map 
configuration for a Modbus TCP/IP client.

 Unit ID - This indicates the Unit Id (Unit Identifier) list for which 
Modbus TCP/IP server should respond. Modbus requests with 
any other Unit Id apart from that configured here would be ignored 
and not responded by the Modbus TCP/IP server. It is value from 
1 - 254.

4. Enter appropriate details in each of the fields and click OK
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The ModbusMapSettings window appears

5. The various fields seen in the window and a brief description on each 
of the them are given in the following table.

Fields Description

Modbus Configuration 
Name

This indicates the Modbus configuration name. This 
shall be used to identify a Modbus map configuration for 
a Modbus TCP/IP client.

Unit ID This refers to the unit identifier in case of the Modbus 
TCP/IP client request. Different Modbus maps should 
have unique unit identifier configured so that when a 
Modbus TCP/IP client requests with a Unit Identifier, 
CIU shall pick up the corresponding Modbus map and 
present the data accordingly.

Turn around Delay This refers to the CIU’s response to any Modbus 
requests after the specified turn around delay in milli 
seconds. 
Value is from 0 to 65535. Default value is 20.

Modbus mapping This indicates the Modbus mapping type. Supported 
types are: 
� Entis Pro Complaint
� User specified 
� CIU Plus Complaint 

For more information on User specified modbus maps, 
refer to section 3.2.9.1 and section 3.2.9.2

Absolute start address This indicates the absolute start address of the Modbus 
tank record.
Values are in decimal.

6. Enter the details as required and click Apply.

NOTES: 1. Click the Apply button after filling details in both Tanks and Entities Tab.

2. Modbus Address displays the relative Modbus address for the Tank 
entities. It is a read-only field.
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3.2.11.2 Delete TCP/IP Modbus map

On the CIU 888 node, right-click and select Delete exisiting TCP/
IP modbus map from the menu.

 

7. The Delete TCP/IP Modbus Map window appears.

8. Select the name of the Modbus map to be deleted from the drop-
down list and click OK.

The Modbus map is deleted.
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3.2.11.3 View/Edit Modbus TCP/IP Maps

1. On the CIU 888 node, right-click and select View / Edit TCP/IP
modbus map from the menu.

2. The View/Edit TCP/IP Modbus Map window appears.

3. Select the name of the modbus map to be viewed from the drop-
down list and click OK.

The ModbusMapSettings window is displayed for viewing and
editing.

Click the apply button to save changes before navigating to other tabs. Failing to do so may 
lead to wrong values getting displayed.
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3.3 Sending Configuration to CIU 888

1. On the CIU 888 node, right-click and choose Send configuration to 
CIU 888.

2. The CIU 888 Connection Details window appears.

3. In the Service Port address box, type the name of the service port 
address.

4. In the User name box, type the User name.

5. In the Password box, type the password.

6. In the Configuration box, select the New Configuration or update 
configuration.

7. Click Send Configuration to CIU 888.
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3.4 Generating INI Files

1. On the CIU 888 node, right-click and choose Send configuration to 
CIU 888.

2. The CIU 888 Connection Details window appears.

 

3. In the Service Port address box, type the name of the service port 
address.

4. In the User name box, type the User name.

5. In the Password box, type the password.

6. Click Generate INI Files.
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3.5 Verifying Configuration

1. On the CIU 888 node, right-click and choose Send configuration to 
CIU 888.

2. The CIU 888 Connection Details window appears.

3. In the Service Port address box, type the name of the service port 
address.

4. In the User name box, type the user name.

5. In the Password box, type the password.

6. Click Verify Configuration.
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3.6 Importing an existing site configuration

1. From the CIU 888 Service Tool window, Choose File > Open.

The SelectSiteForm window appears.

2. Click Import.
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The Open window appears.

3. Select the site database file and click Open.

The files are imported to the current CIU 888 Service tool.

3.7 Opening an existing site configuration

1. From the CIU 888 Service Tool window, Choose File > Open.
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The SelectSiteForm window appears.

2. Select the required site and Click Select.

You can see the selected site details now.

NOTE: Migrating Service tool database from previous releases to the current release 
(R130.1) is possible.
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CHAPTER 4 COMMISSIONING OF A STANDALONE SYSTEM SETUP

Perform the following steps to commission a standalone CIU 888 
system setup:

1. Log on to the CIU 888 and changing the initial password, see section 
4.2.1

2. Verify the CIU 888 license, see section 4.2.2

3. Configure the site using Service Tool, see section 4.3

4. Send the site configuration to the CIU 888, see section 4.4

5. Generate the INI files, see section 4.5

6. Start the Entis Pro system connected to the CIU 888, and loading the 
INI files in Entis Pro, see section 4.6

7. Verify the CIU 888 system setup is working properly, see section 4.7

8. Seal the CIU 888, see section 4.8

4.1 Requirements for commissioning

For the commissioning of a standalone CIU 888 system setup the 
following requirements must be met:

 The electrical and mechanical installation of the CIU 888 must be 
completed. Refer to the Installation Manual CIU 888 (Part No. 
4417590) for more information.

 The CIU 888 must be switched on, see section 7.1.1

 Both the W&M lock key switch and the Configuration lock key switch 
must be in ‘unlocked’ position, see section 7.2

 A PC/laptop running the CIU 888 Service Tool must be connected to 
the Service port of the CIU 888 using a Cat. 5 Ethernet cable (patch 
or crossover). The Service port is located at the front of the CIU 888 
(see FIGURE 4-1). See Chapter 3 for more information about the 
CIU 888 Service Tool. 

FIGURE  4-1 CIU 888: Service port
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4.2 Running the initial setup of the CIU 888

The first step in the procedure for the commissioning of a standalone 
CIU 888 system setup is running the initial setup.

4.2.1 Logging on to the CIU 888 and changing the initial password

During the initial setup, a user has to log on to the CIU 888 and change 
the initial password first.

Procedure:

1. On the PC/laptop connected to the CIU 888, launch a browser.

2. Enter the IP address of the CIU 888 in the address bar of the 
browser. The IP address is: 192.168.1.1. Press the Enter key.
The Login window of the CIU 888 is displayed. 

FIGURE  4-2 CIU 888: Login window

3. Enter the username and password to log in to the CIU 888. The 
username is: ciuadmin. The initial password is CIU888@Enraf. 
Click LOG IN.
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After entering a valid username and password, the CIU 888 prompts 
to change the password of the ciuadmin account (see FIGURE 4-3). 

FIGURE  4-3 CIU 888: Change Password window

NOTE: Changing the password is only required during the initial setup of the CIU 888.

4. Change the password of the ciuadmin account.

a) Enter the current password in the Old Password text box.

b) Enter the new password in the New Password text box and in the 
Confirm Password text box.
The password must meet the following criteria:
- It must not be the same as the previous password
- It must not contain any dictionary words (for example, password)
- It must be at least eight characters long
- It must contain at least one number and one special character
- It must not contain special characters !, ’ and ” 
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c) Click Apply.
The CIU 888 Web interface is displayed. By default, the 
DIAGNOSTICS window is displayed. (see FIGURE 4-4).

FIGURE  4-4 CIU 888 Web interface: Diagnostics window

4.2.2 Verifying the CIU 888 license

NOTE: When the initial password is changed, verify if a license is installed on 
the CIU 888 and if it supports the functionality ordered.Refer to the 
Firmware Upgrade Manual (Part No. 4417596) for more information about the 
CIU 888 license.
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Perform the following procedure:

1. In the CIU 888 Web interface, click CONFIGURE in the section 
menu bar. 
The CONFIGURE window is displayed (see FIGURE 4-5). 

FIGURE  4-5 CIU 888 Web interface: Configure window 

2. If a license is installed on the CIU 888, ‘LICENSE_OK’ is displayed in 
the License status field. If no license is installed, the field is empty. In 
this case, contact Honeywell.
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3. Click View License to view the details of the license currently 
installed on the CIU 888.
The View License window is displayed (see FIGURE 4-6). 

FIGURE  4-6 CIU 888 Web interface: View License window

4. Verify if the correct license is installed on the CIU 888. If not, contact 
Honeywell.

4.3 Setting up the site configuration

After the initial set up of the CIU 888 is completed, set up the site 
configuration using CIU 888 Service Tool. The site configuration can be 
set either by:

 Creating a new site configuration, see section 3.2.

or

 Importing an existing CIU 888 site configuration, see section 3.6.

4.3.1 Configuration procedure in CIU 888 Service Tool

Perform the following procedure to configure a site using CIU 888 
Service Tool:

1. Preparation 
Before starting the creating and configuring the site, a number of 
details must be known, e.g. site layout, information about field 
cabling, tag names of site elements (i.e. gauges, tanks and CIUs), 
tank information (tank strapping tables or tank capacity tables, roof 
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details, etc.), information on types of stored product, host 
communication setup (if applicable).

2. Creating the site and defining the global settings
The creation of the site allows CIU 888 Service Tool to store a 
configuration set. The global settings are required for initiating the 
site configuration. Once the global settings are defined, CIU 888 
Service Tool creates a site database.

3. Creating and configuring the tanks
Tank strapping tables or tank capacity tables can be linked via an 
external file.

4. Linking of the data inputs and tanks.

The site configuration created with Service Tool is saved in the folder 
C:\Program Files (x86)\Honeywell\CIU 888 Service Tool R130.1. 

This folder also contains the following sub-folders:

 INI
This folder is reserved for Entis Pro INI files generated with 
Service Tool.

 LOG
This folder is reserved for log files.

 STR
This folder is reserved for strapping table files linked to the tanks in 
the site configuration.

4.4 Sending the site configuration to the CIU 888

When the site configuration is set up, send the site configuration to the 
CIU 888 using the CIU 888 Service Tool, see section 3.3.

4.5 Generating INI files

When the site configuration is sent to the CIU 888, generate the INI files 
needed for Entis Pro.

Refer to section 3.4 for detailed information about generating INI files 
using CIU 888 Service Tool.

4.6 Starting Entis Pro and loading the updated INI files in Entis Pro

When the INI files are generated, start the Entis Pro system connected 
to the CIU 888 and then load the INI files in Entis Pro. Refer to the 
Configuration manual Entis Pro version 2.70x for Windows 7 (Part 
No. 4416381) for more information.
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4.7 Verifying the working of the system setup

The last step in the commissioning procedure is verifying if the CIU 888 
system setup is working properly.

To verify the working of the system setup, the CIU 888 must be 
connected to:

 PC/laptop running the CIU 888 Service Tool via Service port located 
at the front using a Cat. 5 Ethernet cable 

 PC/laptop running the Modbus Host (e.g. Entis Pro) via one of the 
configured serial host ports using RS-232/RS-485 cable (see 
FIGURE 4-7)

FIGURE  4-7 CIU 888: Serial host ports

 PC/laptop running the Modbus TCP/IP Host via one of the configured 
ethernet host ports using network cable (see FIGURE 4-8)

FIGURE  4-8 CIU 888: FTE A, FTE B and LAN ports

Perform the following procedure:

1. Launch the CIU 888 Web interface. See section 3.1.4 for more 
information.

2. Verify the CIU 888 configuration options in the Web interface.

3. Logout of the Web interface.

4. Verify the CIU 888 functioning by checking the received values on 
the Modbus host. 
Configuration Manual Part No.: 4417584_Rev04
4 - 8 CIU 888



Commissioning of a Standalone System Setup
4.8 Sealing the CIU 888

If the CIU 888 sealing option is licensed, the next step is to have it 
sealed by a representative of the W&M authorities or by a W&M 
accredited user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) 
for more information.

NOTE: If the CIU 888 does not feature the option to be sealed, the W&M lock key 
switch and the configuration lock key switch can either be locked or left 
unlocked.
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CHAPTER 5 COMMISSIONING OF A REDUNDANT SYSTEM SETUP 

Redundancy is a common approach to improve the reliability and 
availability of a system. In a redundant CIU 888 system setup, one 
CIU 888 (usually the primary CIU 888) has the active role and its 
counterpart (usually the secondary CIU 888) has the passive role. 
During normal operation, the CIU 888 that has the active role scans the 
connected gauges for data and provides the measured and calculated 
data to host systems.

If both CIU 888s in a redundant system setup are fully synchronized 
and the connected host initiates a switchover, the CIU 888 that has the 
active role assumes the passive role. The CIU 888 that has the passive 
role assumes the active role and continues to perform the tasks that are
performed by the CIU 888 that previously had the active role.

Switchover command issued by Entis Pro via Modbus serial is one such 
example.

NOTE: Refer to the Protocol Manual - Modbus Host (Part No. 4417588) for more 
information about setting up of Modbus host for redundancy.

NOTE: The active CIU 888 can either be the primary CIU 888 or the secondary 
CIU 888.

The redundancy status of the CIU 888 (active or passive) is presented 
through the following (host) systems:

 Entis Pro via Modbus serial

 Other Modbus host systems

 CIU 888 local display

Perform the following procedure to commission a redundant CIU 888 
system setup:

1. Log on to the CIU 888 and changing the initial password, see
section 5.2

2. Verify the CIU 888 license, see section 5.2

3. Configure the site using Service Tool, see section 5.3

4. Send the site configuration to the primary CIU 888, see section 5.4

5. Commission the secondary CIU 888, see section 5.5

6. Generate the INI files, see section 5.6 and Start the Entis Pro system
connected to the CIU 888, and load the INI files in Entis Pro, see
section 5.7

7. Verify the working of the system setup, see section 5.8

8. Seal the CIU 888s, see section 5.9
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5.1 Requirements for commissioning

For commissioning of a redundant CIU 888 system setup, the following 
requirements must be met:

 The mechanical and electrical installation of both the primary
CIU 888 and the secondary CIU 888 must be completed. Refer to
the CIU 888 Installation Manual (Part No. 4417590) for more
information.

 Both the primary CIU 888 and the secondary CIU 888 must be
switched on. See section 7.1.1 for more information.

 The W&M lock key switch and the Configuration lock key switch of
both the primary CIU 888 and the secondary CIU 888 must be in
‘unlocked’ position. See section 7.2 for more information.

 The primary CIU 888 and the secondary CIU 888 must be linked
through their Sync Link ports using a Cat. 5 Ethernet cable (patch or
crossover). The Sync Link port is located at the back of the CIU 888
(see FIGURE 5-1).

FIGURE  5-1 CIU 888: Sync Link port

 A PC/laptop running the CIU 888 Configuration System must be
connected to the Service port of the primary CIU 888 using a Cat. 5
Ethernet cable (patch or crossover). The Service port is located at
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the front of the CIU 888 (see FIGURE 5-2). See CHAPTER 3 for 
more information about the CIU 888 Configuration System. 

FIGURE  5-2 CIU 888: Service port

 During commissioning of the CIU 888s, the Entis Pro system(s)
connected to the CIU 888s must be shut down.

5.2 Running the initial setup of the primary CIU 888

The first step in the procedure for the commissioning of a redundant 
CIU 888 system setup is performing the initial setup procedure of the 
primary CIU 888. See section 4.2 for more information.

5.3 Setting up the site configuration

When the initial setup of the primary CIU 888 is completed, then set up 
the site configuration using CIU 888 Service Tool. The site configuration 
can be set up either by:

 Creating a new site configuration, see section 3.2.

or

 Importing an existing CIU 888 site configuration, see section 3.6.

5.4 Sending the site configuration to the primary CIU 888

When the site configuration is set up, send the site configuration to the 
primary CIU 888 using the CIU 888 Service Tool. See section 3.3 for 
more information.

5.5 Commissioning of the secondary CIU 888

When the primary CIU 888 is commissioned, then configure its 
counterpart as preferred secondary CIU 888.
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Perform the following procedure:

1. On the display of the secondary CIU 888, highlight the 
Configuration icon in the Status Dashboard using the navigation 
keys. Next, press the OK button.
The Configuration menu screen is displayed (see FIGURE 5-3). 

FIGURE  5-3 CIU 888 display: Configuration menu screen

2. Highlight the required Redundancy option using the navigation 
keys. Click the OK button.
The Redundancy screen is displayed (see FIGURE 5-4). 

FIGURE  5-4 CIU 888 display: Redundancy screen
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3. Highlight the Preferred secondary option using the navigation keys
and then press the OK key.
The Confirm Changes screen is displayed.

FIGURE  5-5 CIU 888 display: Confirm Changes screen

4. Highlight the OK option using the display keys. Click OK key.
The secondary CIU 888 is reset to the factory settings and reboots
twice. Because the Entis Pro system(s) connected to the CIU 888s is
shutdown, redundancy switchover is disabled during reboot.

5. Connect the PC/Laptop to the secondary CIU 888. Log on to the
secondary CIU 888 and change the initial password, refer to
section 4.2.1.

6. Verify the CIU 888 license, refer to section 4.2.2.

When commissioning of both the primary CIU 888 and secondary 
CIU 888 is completed, the role of each CIU 888 in the redundant 
system setup is indicated in the Status Dashboard (see FIGURE 5-
6). 

FIGURE  5-6 Status Dashboard of primary CIU 888 (left) and secondary CIU 888 (right)
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5.6 Generating INI files

When the site configuration is sent to primary CIU 888, then generate 
the INI files required for Entis Pro.

Refer to the section 3.4 for detailed information about generating INI 
files using CIU 888 Service Tool.

5.7 Starting Entis Pro and loading the INI files in Entis Pro

When the INI files are updated, then start the Entis Pro system(s) 
connected to the CIU 888s and then load the INI files in Entis Pro. Refer 
to the Configuration manual Entis Pro version 2.70x for Windows 7
(Part No. 4416381) for more information.

5.8 Verifying the working of the system setup

The final step in the commissioning procedure is verifying if the 
redundant CIU 888 system setup is working properly. See section 4.7 
for more information.

5.9 Sealing the CIU 888s

If the CIU 888s sealing option is licensed, the next step is to have them 
sealed by a representative of the W&M authorities or by a W&M 
accredited user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) 
for more information.

NOTE: If the CIU 888s do not feature the option to be sealed, the W&M lock key 
switches and configuration lock key switches can either be locked or left 
unlocked.
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CHAPTER 6 UPDATING CIU 888 SITE CONFIGURATION 

If there are changes in the CIU 888 system setup, these changes must 
be implemented in the site configuration. Subsequently, the updated 
site configuration must be sent to the CIU 888 for the changes to 
become effective.

Changes in the CIU 888 system setup can be the result of the following. 
For example:

 Connection of additional tank gauging instruments to the CIU 888

 Connection of additional host systems to the CIU 888

 Installation of a new CIU 888 license resulting in the expansion of the 
features and functionalities of the CIU 888 (e.g. redundancy, support 
of a larger number of tanks)

Perform the following steps to update the CIU 888 site configuration:

1. Implement the required changes in the site configuration, see 
section 6.3

2. Send the updated site configuration to the CIU 888, see section 6.4

3. Generate the INI files required for Entis Pro, see section 6.5

4. Start the Entis Pro system connected to the CIU 888, and load the 
INI files in Entis Pro, see section 6.6

5. Verify the working of the system setup, see section 6.7

6. Seal the CIU 888, see section 6.8

6.1 Requirements for updating the non redundant CIU 888 site config-
uration

The following requirements must be met in order to update the CIU 888 
site configuration: 

 The CIU 888 must be switched on. See section 7.1.1 for more 
information.

 For W&M parameters update, W&M lock key switch and 
Configuration lock key switch of the CIU 888 must be in 'unlocked' 
position. See section 7.2 for more information.

 For non W&M parameters update, Configuration lock key switch of 
the CIU 888 must be in 'unlocked' position. See section 7.2 for more 
information.

 A PC/laptop running the CIU 888 Configuration System must be 
connected to the Service port of the CIU 888 using a Cat. 5 Ethernet 
cable (patch or crossover). The Service port is located at the front of 
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the CIU 888 (see FIGURE 6-1). See Chapter 3 for more information 
about the CIU 888 Configuration System. 

FIGURE  6-1 CIU 888: Service port

6.2 Requirements for updating the redundant CIU 888 site configura-
tion

The following requirements must be met in order to update the CIU 888 
site configuration: 

 The primary CIU 888 and the secondary CIU 888 must be in sync.

 For W&M parameters update, W&M lock key switch and
Configuration lock key switch of Primary CIU 888 and Secondary
CIU 888 must be in 'unlocked' position. See section 7.2 for more
information.

 For non W&M parameters update, Configuration lock key switch of
Primary CIU 888 and Secondary CIU 888 must be in 'unlocked'
position. See section 7.2 for more information.

 A PC/laptop running the CIU 888 Configuration System must be
connected to the Service port of the CIU 888 using a Cat. 5 Ethernet
cable (patch or crossover). The Service port is located at the front of
the CIU 888 (see FIGURE 6-1). See Chapter 3 for more information
about the CIU 888 Configuration System.

 During updating of the CIU 888 site configuration, the Entis Pro
system connected to the CIU 888 must be shut down.

6.3 Implementing the required changes in the site configuration

Perform the following procedure to implement the required changes in 
the site configuration:

1. Launch CIU 888 Service Tool (refer to section 3.2.2).

2. Load the applicable CIU 888 site configuration (refer to section 3.7).

3. Navigate through the CIU site nodes and do the required changes. If
any new site nodes are required, create and configure them (refer to
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section 3.2.4, section 3.2.5, section 3.2.6, section 3.2.7, and 
section 3.2.8).

6.4 Sending the site configuration to the CIU 888

When the site configuration is set up, send the site configuration to the 
CIU 888 using the CIU 888 Service Tool, see section 3.3.

NOTE: In case of updating redundant CIU 888, the configuration should be sent to 
Primary CIU 888.

6.5 Generating the INI files

When the site configuration is sent to CIU 888, the next step is to 
generate the INI files needed for Entis Pro. Refer to section 3.4 for 
detailed information about generating INI files using Service Tool.

6.6 Starting Entis Pro and reloading INI files in Entis Pro

When the INI files have been generated, then start the Entis Pro system 
connected to the CIU 888 and then load the INI files in Entis Pro. Refer 
to the Configuration manual Entis Pro version 2.70x for Windows 7
(Part No. 4416381) for more information.

6.7 Verifying the working of the CIU 888 system setup

The final step in the procedure for updating the CIU 888 system setup is 
verifying if the system setup is working properly. See section 4.7 for 
more information.

6.8 Sealing the CIU 888

If the CIU 888 features the option to be sealed, the next step is to have 
it sealed by a representative of the W&M authorities or by a W&M 
accredited user. Refer to the CIU 888 Sealing Guide (Part No. 4417595) 
for more information.

NOTE: If the CIU 888 does not feature the option to be sealed, the W&M lock key 
switch can either be locked or left unlocked.
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CHAPTER 7 GENERAL CIU 888 FUNCTIONS

7.1 (Re)starting and shutting down the CIU 888

7.1.1 Starting the CIU 888

When the CIU 888 is connected to the mains, you can start the CIU 888 
using the on/off switch at the back of the device (see FIGURE 7-1). 

FIGURE  7-1 CIU 888: on/off switch

During startup, the CIU 888 Loading... splash screen is shown on the 
CIU 888 display (see FIGURE 7-2). 

FIGURE  7-2 CIU 888 display: CIU 888 Loading... splash screen

NOTE: If the CIU 888 is built into a storage cabinet, the on/off switch should be in the 
‘ON’ position as it is no longer accessible. In this case, you can start the 
CIU 888 by switching on the mains.
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7.1.2 Restarting the CIU 888

You can restart the CIU 888 via the CIU 888 Web interface. To restart 
the CIU 888, select Restart CIU from the CIU 888 menu (see FIGURE 
7-3). 

FIGURE  7-3 CIU 888 Web interface: Restart CIU option in CIU 888 menu

During restart, the CIU 888 Restarting... splash screen is shown on the 
CIU 888 display (see FIGURE 7-4). 

FIGURE  7-4 CIU 888 display: CIU 888 Restarting... splash screen
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7.1.3 Shutting down the CIU 888 

Shutting down the CIU 888 is necessary if, maintenance must be 
performed on the CIU 888 or if the CIU 888 must be replaced. You can 
shut down the CIU 888 via the CIU 888 Web interface. To shut down the 
CIU 888, select Shutdown CIU from the CIU 888 menu (see FIGURE 
7-5). 

FIGURE  7-5 CIU 888 Web interface: Shutdown CIU option in CIU 888 menu

NOTE: To switch the CIU 888 back, use the on/off switch at the back of the device, see 
section 7.1.1. Because the on/off switch is still in the ‘ON’ position, the on/off 
switch must be switched to the ‘OFF’ position first. Subsequently, the CIU 888 
can be started by switching the on/off switch to the ‘ON’ position.
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7.2 W&M lock key switch and Configuration lock key switch

The CIU 888 features two key switches located at the front of the 
device:

 W&M lock key switch, see section 7.2.1.

 Configuration lock key switch, see section 7.2.2.

7.2.1 W&M lock key switch

The W&M lock key switch is used for locking and unlocking the W&M 
relevant configuration settings of the CIU 888. The key switch is located 
at the front of the CIU 888, and is fitted with a cover (see FIGURE 7-6). 

FIGURE  7-6 CIU 888: W&M lock key switch

7.2.1.1 Unlocking the W&M relevant configuration settings

Perform the following steps to unlock the W&M relevant configuration 
settings of the CIU 888:

1. If the cover of the W&M lock key switch is sealed, remove the 
hardware seal (wire) in order to get access to the key switch.

2. Take the key for locking/unlocking the W&M relevant configuration 
settings and insert it in the key switch. Then, turn the key counter-
clockwise.
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On the CIU 888 display, the status of the W&M lock key switch 
changes from  (‘locked’) to  (‘unlocked’) (see FIGURE 7-7). 

FIGURE  7-7 CIU 888 display: W&M relevant configuration settings are unlocked

3. Remove the key from the key switch and store it.

7.2.1.2 Locking the W&M relevant configuration settings

Perform the following steps to lock the W&M relevant configuration 
settings of the CIU 888:

1. Take the key for locking/unlocking the W&M relevant configuration 
settings.

2. Insert the key in the W&M lock key switch. Then, turn the key 
clockwise.
On the CIU 888 display, the status of the W&M lock key switch 
changes from  (‘unlocked’) to  (‘locked’) (see FIGURE 7-8). 

FIGURE  7-8 CIU 888 display: W&M relevant configuration settings are locked
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3. Remove the key from the key switch and store it.

7.2.2 Configuration lock key switch 

The Configuration lock key switch is used for locking and unlocking the 
configuration settings (non-W&M relevant and W&M relevant) of the 
CIU 888. The key switch is located at the front of the CIU 888 (see 
FIGURE 7-9). 

FIGURE  7-9 CIU 888: Configuration lock key switch

7.2.2.1 Unlocking the configuration settings

Perform the following steps to unlock the configuration settings of the 
CIU 888:

1. Take the key for locking/unlocking the configuration settings.

2. Insert the key in the Configuration lock key switch, and then turn the 
key counterclockwise.
On the Status Dashboard, the status of the Configuration lock key 
switch changes from  (‘locked’) to  (‘unlocked’) (see FIGURE 
7-10).

FIGURE  7-10 Status Dashboard: configuration settings are unlocked
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3. Remove the key from the key switch and store it.

7.2.2.2 Locking the configuration settings

Perform the following steps to lock the configuration settings of the 
CIU 888:

1. Take the key for locking/unlocking the configuration settings.

2. Insert the key in the Configuration lock key switch, and then turn the 
key clockwise.
On the Status Dashboard, the status of the Configuration lock key 
switch changes from  (‘unlocked’) to  (‘locked’) (see FIGURE 
7-11). 

FIGURE  7-11 Status Dashboard: configuration settings are locked

3. Remove the key from the key switch and store it.
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Appendix A - Data Handling
APPENDIX A DATA HANDLING

A.1 Engineering units

System engineering units are required for proper rounding of the 
internal engineering units. The system engineering units are selected 
during the configuration of the CIU 888, and also in a later stadium 
when the settings of the CIU 888 are configured (partly or fully) and the 
CIU 888 is operational. The CIU 888 Web interface presents the 
configuration settings in the selected system engineering units.

The CIU 888 supports the same set of engineering units as supported 
by the Service Tool.

A.2 Data presentation

A.2.1 Decimal and thousand separators

A.2.1.1 Decimal separator

The CIU 888 displays its floating point numeric data with a decimal 
separator which is either a dot (default) or a comma. Other characters 
are not allowed. A number cannot start nor end with a decimal 
separator. For example, ‘0.2’ is correct, but ‘.2’ is not correct.

NOTE: The decimal separator parameter is under the W&M seal.

A.2.1.2 Thousand separator

The CIU 888 displays its numeric data with a thousand separator which 
is either a dot, a comma (default) or no separator (space). Other 
characters are not allowed. The thousand separator is applied before 
and after the decimal separator to group three digits. A number cannot 
start nor end with a thousand separator.

NOTE: The thousand separator parameter falls under the W&M seal.

A.2.1.3 Configuring the decimal separator and thousand separator

The decimal separator and thousand separator are both initialized 
during setup of the site configuration in Service Tool, and are taken from 
the settings configured for the PC/laptop running Service Tool.

To configure the decimal separator and thousand separator:
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1. On the PC/laptop running Service Tool, go to  (Start) > Control 
Panel.
The Control Panel is displayed (see FIGURE A-1). 

FIGURE  A-1 Control Panel
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2. Click Clock, Language, and Region.
The Clock, Language, and Region window is displayed (see 
FIGURE A-2). 

FIGURE  A-2 Control Panel: Clock, Language, and Region window
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3. Click Region and Language. 
The Region and Language window is displayed. By default, the 
Formats tab is displayed (see FIGURE A-3). 

FIGURE  A-3 Region and Language window
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4. Click Additional settings.... 
The Customize Format window is displayed (see FIGURE A-4). 

FIGURE  A-4 Customize Format window

5. From the list box next to ‘Decimal symbol:’ select the symbol to be 
used as decimal separator.

6. From the list box next to ‘Digit grouping symbol:’ select the symbol to 
be used as thousand separator.

7. Click OK to save the settings and to close the window.

A.2.2 Time stamped data

Measured and calculated data is accompanied with a time stamp with 
the same resolution as the time stamp configured in the CIU 880.

See section A.2.3 for more information about time resolutions.

A.2.3 Date and time presentation

A.2.3.1 Date

Dates are always presented in ISO format, i.e. YYYY-MM-DD, where:

 YYYY = the year (all digits)

 MM = the month (01 (January) to 12 (December))

 DD = the day (01 to 31)
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For example, ‘3rd October 2013’ is presented as 2013-10-03. 

A.2.3.2 Time

Times are presented in one of the following formats:

 Times in minutes resolution are presented as hh:mm

 Times in seconds resolution are presented as hh:mm:ss

 Times in milliseconds resolution are presented as hh:mm:ss.ttt

where:

 hh = zero-padded hour between 00 and 24

 mm = zero-padded minute between 00 and 59

 ss = zero-padded second between 00 and 60

 ttt = zero-padded between 000 and 999

NOTE: The AM/PM part of time should not be at the start. So time format AM 03:55 is 
not allowed. Only the standard windows time formats are supported.

A.3 List of entities not needing restart after a change

TABLE  A-1 List of CIU 888 entities that do not require a restart after changing

Entity Name Entity Number

VolumeCorrections 24

ProductTRef 26

ProductDref 30

ProductDrefStatus 31

SedAndWater 32

ProductTC 33

ProductTCStatus 34

LiqVolRatio 35

ProductLevel 40

ProductLevelStatus 41

WaterLevel 42

WaterLevelStatus 43

ProductTemp 44

ProductTempStatus 45

VapRoomTemp 46

VapRoomTempStatus 47

VapRoomPressure 48
Configuration Manual Part No.: 4417584_Rev04
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VapRoomPressureStatus 49

Dobs 50

DobsStatus 51

WaterVol 56

WaterVolStatus 57

MolarWeight 79

TankTRef 90

ThermalexpCoeffTankshell 91

TankAirDensity 92

AmbientTemperature 103

AmbientTemperatureStatus 104

InsulationFactor 109

LowestTemperatureElement 110

Tobs 118

TobsStatus 119

CTL (VCF) 124

CTLStatus 125

TCF 126

TCFStatus 127

DCF 128

DCFStatus 129

TankTypeStatus 133

ShellCapacityStatus 134

LowTOVStatus 135

HighTOVStatus 136

GSVCalcTypeStatus 138

ProductCodeStatus 139

VolumeCorrectionsStatus 140

ProductTRefStatus 142

SedAndWaterStatus 143

LiqVolRatioStatus 144

MolarWeightStatus 145

TankTRefStatus 155

TankTCStatus 156

AirDensityStatus 157

InsulationFactorStatus 158

Entity Name Entity Number
Part No.: 4417584_Rev04 Configuration Manual
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WaterDipOffset 2070

NegativeLevelsEnabled 2073

Moving TripValue 2100

MovingIntervalTime 2101

StandardAmbientAirPressure 3026

TankPressureOrientation 3028

GaugeAlarmHandling 3045

IPConfigurationCRC 3508

IPDipswitchStatus 3511

TankZoneControl 4003

TankZoneStart 4004

TankZoneEnd 4005

TankZoneCorrection 4006

FloMul 5042

FloIntervalTime 5043

GaugeDetail 6500

GSVCalcType 8122

ProductCode 8123

Entity Name Entity Number
Configuration Manual Part No.: 4417584_Rev04
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APPENDIX B SCANNING

The main task of the CIU 888 is scanning the connected tank gauging 
instruments continuously for the measured values of the connected 
devices.

B.1 Scanning Philosophy

CIU 888 incorporates time-based scanning for better scanning 
performance. CIU 888 maintains a scan items pool per field port / 
sequenced field ports that has the list of scan items to be scanned. 
Each scan item is allocated a minimum scan period and a maximum 
scan period. Minimum scan period is the minimum expected time 
interval at which the scan item must be scheduled in milliseconds and 
maximum scan period is maximum time interval within which the scan 
item must be scheduled in milliseconds.

Based on the scan periods and current scanning pattern of the scan 
items, CIU 888's scanning algorithm picks up the most useful item 
among all the scan items configured for a field port and sends it to the 
field. In case of sequenced field ports (channel sequencing), CIU 888's 
scanning algorithm picks up the most useful item among all the scan 
items configured for the field ports that are sequenced.

Following are the various scan items processed by CIU 888.

B.2 Configured Foreground scan items

The CIU 888 scans measurable data inputs (for example, product level) 
that are configured in the foreground scan more often than data inputs 
configured in the background scan.

In tank gauging, the most important data to retrieve from gauging 
instruments on a tank is the level. The core competency of the scanner 
is to update each value on a regular basis. If tank calculation is part of 
the solution, a change of each new level value triggers the calculations 
module to recalculate the tank record.

B.3 Configured Background scan items

Measured data inputs that do not change frequently, for example the 
average temperature of a tank, do not need to be scanned with the 
same scan rate as the values that are scanned in the foreground scan.

The CIU 888 scans all measurable data inputs that are configured in the 
foreground with a higher priority ((i.e) less minimum and maximum scan 
period) than the measurable data inputs that are configured in the 
background scan.
Part No.: 4417584_Rev04 Configuration Manual
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B.4 Command scan items

When gauge commands are issued from the Host system, gauge 
command scan items are added to the scan items pool. Gauge 
commands scan items are scheduled with a higher priority ((i.e) less 
minimum and maximum scan period) than configured foreground and 
background items.

B.5 Service Messages

When service messages are issued from Service tools like Engauge, 
Winsetup service messages are added to the scan items pool. Service 
messages are scheduled with a higher priority ((i.e) less minimum and 
maximum scan period) than configured foreground and background 
items.

Adaptive scanning based on field device communication failures:

1. Field device retries are made smarter and spread rather than 
configured consecutive retries. 

2. If the communication errors are received for the configured number 
of retries for a field device, the priority of all the scan items for that 
field device will be reduced and retries are skipped until a valid 
response is received for that field device. 

3. On receiving a valid response from the field, the priority of the field 
device is moved to the appropriate level and retry mechanism is 
restored. 

B.6 Priority Agent

CIU 888 also incorporates a Priority Agent which monitors the product 
movement and product level close to Tank High limit and relatively 
prioritizes the scan items by modifying the minimum and maximum scan 
periods of the scan items so that critical parameters are scanned at a 
faster rate compared to the less critical parameters. Priority agent can 
be enabled / disabled with a configuration option.

Priority Agent is disabled - CIU 888 scans the field using a static time 
based scanning algorithm for foreground and background scan items. 
No priority changes happen based on Product movement and Tank 
High Monitoring Limit.

Priority Agent is enabled - CIU 888 scans the field using a dynamic time 
scanning algorithm based on the Product movement and Tank High 
monitoring limit. Scan item's priority changes happen based on Product 
movement and Tank High Monitoring Limit. That is, a relative 
prioritization is done between static tanks (tanks with no product 
movement), dynamic tanks (tanks with product movement), dynamic 
tanks in which product level is beyond the configured Tank high 
monitoring limit.
Configuration Manual Part No.: 4417584_Rev04
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The following table provides various priority levels incorporated in CIU 
888.

Priority Scenario

Very High Product level when it is close to Tank high limit (beyond the 
configured Tank high monitoring limit) and product movement is 
detected.

High Service messages received over Service Ethernet port
Command scan messages.

Above Normal Product level when detected to be moving in a specific 
direction.
Product level when it is close to Tank high limit and no product 
movement is detected
Product level when it is close to Tank high limit, and device 
communication errors occur irrespective of product movement 
being detected / not.

Normal Foreground parameters (for example, Level) of static tanks i.e. 
no product movement is detected.
Product level of tanks where it was moving when device 
communication errors occur, Service / emulation messages 
received over serial host ports.

Below Normal Background parameters (for example, Temperature, Density)
Foreground parameters (for example, Level) of static tanks 
when device communication errors occur.

Low Background parameters of tanks when device communication 
errors occur.
Part No.: 4417584_Rev04 Configuration Manual
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APPENDIX C REDUNDANCY

C.1 Sync Link and database synchronization

Redundancy between a pair of CIU 888s is realized by synchronizing 
the databases of the CIU 888s. Real-time and continuous 
synchronization ensures that all recently measured data is available to 
both CIU 888s and is required to minimize switch-over time.

To achieve real-time and continuous synchronization, a dedicated 
Ethernet connection between the pair of CIU 888s must be established, 
called the Sync Link. The Sync Link connection is also used to 
determine the actual role of each CIU 888 (active or passive). To 
establish the Sync Link connection, the CIU 888s have to be connected 
by means of a Cat. 5. Ethernet cable.

In a redundant CIU 888 system setup, the following data stores are kept 
synchronized:

 Real-time data

 Active gauge commands, including status

 Configuration data

 Operational data (manual overwrites and gauge commands)

 Clock

NOTE: A failure in the Sync Link connection will disable a synchronization.

The Sync Link port is located at the back of the CIU 888 (see 
FIGURE C-1). 

FIGURE  C-1 CIU 888: Sync Link port 
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C.2 Supported redundant CIU 888 topologies of deployment

The following redundant CIU 888 topologies of deployment are 
supported:

 RS-232 host port redundancy with redundant CIU 888s and host port 
redundancy on demand of host system (see section C.2.1)

 RS-232 host port redundancy with redundant CIU 888s and data 
synchronization by host system (see section C.2.2)

 Modbus TCP host port redundancy with redundant CIU 888s and 
data synchronization between host systems

C.2.1 RS-232 host port redundancy with redundant CIU 888s and host port 
redundancy on demand of host system

In this configuration, both CIU 888s in the redundant configuration are 
connected to the same host system, for example, Entis Pro (see 
FIGURE C-2). The CIU 888s are connected to the host system via one 
of their fixed host ports. Each host port has its own unique RTU address 
and is configured for communication through Modbus RTU on serial. 

FIGURE  C-2 RS-232 Host port redundancy with redundant CIU 888s and host port redundancy on 
demand of host system
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This configuration is compliant with Entis Pro or any other modbus host 
system. By issuing the appropriate Modbus command, Entis Pro can 
demand to switch over to the secondary CIU 888 if the primary CIU 888 
is not responding anymore and move to Com2/Port 42 to acquire tank 
data. The secondary CIU 888 becomes the active CIU and its host port 
becomes R/W.

NOTE: Refer to the chapter ‘CIU Plus Links’ in the Configuration Manual Entis Pro 
2.70x for Windows (Part No. 4416381) for more information about connecting 
the CIU 888 to the Entis Pro system. 

C.2.2 RS-232 host port redundancy with redundant CIU 888s and data 
synchronization between host systems

In this configuration, each CIU 888 in the redundant configuration is 
connected to a separate host system, for example, Entis Pro (see 
FIGURE C-3). The CIU 888s are connected to the host system via one 
of their fixed Host ports. Each host port has its own unique RTU address 
and is configured for communication through Modbus RTU on serial. By 
connecting each CIU 888 to a separate instance of Entis Pro, an extra 
safety is created in the event of failure of one of the two host systems. 

FIGURE  C-3 RS-232 host port redundancy with redundant pair of CIU 888s and data synchronization 
between host systems
Part No.: 4417584_Rev04 Configuration Manual
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This configuration is compliant with Entis Pro or any other modbus host 
system. By issuing the appropriate Modbus command, Entis Pro can 
demand to switch over to the secondary CIU 888 if the primary CIU 888 
is not responding anymore and move to Com2/Port 42 to acquire tank 
data. The secondary CIU 888 becomes the active CIU and its host port 
becomes R/W.

NOTE: Refer to the chapter ‘CIU Plus Links’ in the Configuration Manual Entis Pro 
2.70x for Windows (Part No. 4416381) for more information about connecting 
the CIU 888 to the Entis Pro system. 

C.2.3 Modbus TCP host port redundancy with redundant CIU 888s and data 
synchronization between host systems

In this configuration, both CIU 888s in the redundant configuration are 
connected to the Honeywell Experion PKS ((see FIGURE C-4)) and to 
other Modbus TCP/IP hosts. The CIU 888s are connected to Experion 
FTE Networks via FTE A & FTE B ports. CIU888s acts as non-FTE 
nodes on FTE network. Each ethernet port has its own unique IP 
address and is configured in Modbus TCP/IP hosts for communication. 
Also, LAN ports can be connected to LAN network which can further be 
accessed by other Modbus TCP/IP client host systems.

At CIU888 level, Modbus maps are created with Unique Unit ID (Slave 
ID) which can be configured in Modbus TCP/IP Client host systems. 
Configuration Manual Part No.: 4417584_Rev04
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This way, each configured map can be accessed in any Modbus TCP/IP 
ports.

FIGURE  C-4 Modbus TCP host port redundancy with redundant CIU 888s and data synchronization 
between host systems 
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C.3 Redundant CIU 888-Experion PKS Integration

Redundant CIU 888 and Experion PKS Integration requires necessary 
configuration changes in CIU 888 using Service tool and in Experion 
PKS using Quick Builder.

C.3.1 Configuring CIU 888

Perform the below steps for the required CIU 888 configuration using 
CIU 888 Service tool:

1. On CIU 888 node, click FTE A port.

2. By default, the FTE tab appears displaying the Properties details.

3. Enter appropriate details in the IP address and Modbus port 
number fields.

4. Select the Tranparency Mode and IP switch over decision maker 
check boxes and click Apply.

5. Click Secondary FTE Host Port tab to view the Properties details.
Configuration Manual Part No.: 4417584_Rev04
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6. Enter an appropriate IP address in the Secondary’s IP address 
field. (For example, if configured Primary CIU 888's IP address is 
given as 10.79.212.182 then the configured Secondary's IP address 
can be given as 10.79.212.184)

7. Click Apply.

8. On CIU 888 node, click FTE B port.

9. By default, the FTE tab appears displaying the Properties details.

10.Enter appropriate details in the IP address and Modbus port 
number fields.

11.Select the Tranparency Mode and IP switch over decision maker 
check boxes and click Apply.

12.Click Secondary FTE Host Port tab to view the Properties details

13.Enter an appropriate IP address in the Secondary’s IP address 
field. (For example, if the configured Primary CIU 888's IP address is 
given as 10.79.212.183 then the configured Secondary's IP address 
can be given as 10.79.212.185). 
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CIU 888 is now configured for Experion PKS integration.

NOTE: When Redundant CIU 888 is integrated with Experion PKS, the IP address of 
the FTE A & FTE B should be configured in the same subnet. 

C.3.1.1 Configuring Modbus maps

Configure Modbus maps in CIU 888 for Experion PKS based on the site 
requirement.   Refer to Configuration manual section 3.2.11 for more 
information on Modbus maps configuration procedures. 

C.3.2 Configuring Experion PKS

Perform the below steps for the required Experion PKS configuration 
using Quick builder in Configuration Studio.

1. On the CIU 888A node, click Channels.

2. Under the Main tab, enter details in the Name and Description
fields.
Configuration Manual Part No.: 4417584_Rev04
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3. Under the Port tab, choose LANVendor from the Port Type drop-
down list and Modbus TCP from the Network Type drop-down list.

4. Under the Redundant Port tab, choose RedundantLANVendor 
from the Port Type drop-down list and Modbus TCP from the 
Network Type drop-down list.
Part No.: 4417584_Rev04 Configuration Manual
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C.3.2.1 Configuring Modbus Controllers

Create Modbus Controller for different type of data inputs and outputs 
based on the site requirement. 

For example, for Holding Registers which are required for calculated 
and measured parameters, a Modbus Controller "ANALOG" is created 
as below and associated with configured Modbus Channel which is CIU 
888_TCP. The IP Address 1 and IP Address 2 are configured with 
Primary CIU 888's FTE A and FTE B IP address.

For example, if Primary CIU 888's FTE A IP address is 10.79.212.182 
and FTE B IP address is 10.79.212.183, then configure IP Address 1 as 
10.79.212.182 & IP Address 2 as 10.79.212.183. Also, configure the 
port numbers as per the CIU 888 FTE A/FTE B configurations.   

PLC Station ID should be configured based on the Unit ID selected for 
Modbus map created in CIU 888 for Experion PKS integration. For 
example, if the Modbus map for Experion PKS is created with Unit ID as 
1, then PLC Station ID should be configured as 1.

ANALOG modbus controller for holding registers is shown in the figure 
below.

Similarly, for Digital Inputs (or Read Discrete Inputs) "INPUT" controller 
is created and for Digital Outputs (Write Coils) "OUT" controller is 
created and downloaded to server.
Configuration Manual Part No.: 4417584_Rev04
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Digital Input Controller for Read Discrete Inputs is as shown in the figure 
below.

Digital Output Controller for Write Coils is as shown in the figure below.
Part No.: 4417584_Rev04 Configuration Manual
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C.3.3 Configure Modbus Points

Based on the Datatypes and Function codes, different points can be 
created which can be associated to the Modbus Controllers configured 
earlier. 

C.3.3.1 Point configuration for Host initiated switchover

CIU 888's redundancy is controlled by host initiated switchovers. 
Hence, the following configuration needs to be done in Experion PKS to 
initiate switchovers. 

C.3.3.2 Configure Digital Output Points (Switchover Command)

For the Switchover command, a Status point 
SWITCHOVERCOMMAND needs to be created in Quick Builder and 
associate to OUTPUT controller created in step 2.2.3.

The PV Source address is given as OUTPUT 1(where OUTPUT is 
Controller and 1 indicates the Modbus address of Coil Output to initiate 
Configuration Manual Part No.: 4417584_Rev04
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as switchover command in CIU 888). Then configure Source and 
Destination Address as OUTPUT 1 and download the point to server. 

C.3.3.3 Configure Digital Input(Hotstandby Status)

HOTSTANDBYSTATUS is a Digital Input created for getting the 
Hotstandby Status of CIU 888. This is associated to the INPUT 
controller and the PV Source Address is given as INPUT 1 (where 
INPUT  indicates the Controller & 1 indicates the Modbus address of the 
Hotstandby status of CIU 888). 
Part No.: 4417584_Rev04 Configuration Manual
CIU 888 C - 13



Redundancy
Configure Number of States as 2 and configure state Descriptors as 
State 1="ON" and State 0="OFF". This will be used in Server scripting 
for executing automatic switchover from Experion PKS. 

In the Scripts Tab under HOTSTANDBYSTATUS status point, click on 
Create New or Edit existing server scripts. 

"Configure Event as OnChange.

"Configure Script Engine as Automatically Allocate 

"Configure Parameter as PV.

"Copy the below script to the script editor. 

if ucase(ParamValue("HOTSTANDBYSTATUS.PV"))= ucase("ON") 
then

ParamValue("SWITCHOVERCOMMAND.OP")= ucase("ON")  

end if

NOTE: This script will check the Hotstandby Status periodically 
(HOTSTANDBYSTATUS.PV) and whenever it changes to ON (which indicates 
CIU 888 as PASSIVE), a switchover command 
Configuration Manual Part No.: 4417584_Rev04
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(SWITCHOVERCOMMAND.OP=ON) is issued to CIU 888 so that the CIU 888 
becomes ACTIVE. 

For the Write Coil for giving Switchover command to CIU 888 to make 
ACTIVE in-case of PASSIVE state, a SWITCHOVERCOMMAND.OP is 
created which is associated to OUTPUT controller. The PV Source 
Address is given as OUTPUT 1 which needs to configured in control tab 
of the point for write.

C.3.4 Configure Points for CIU 888 parameters:

Configure the required points for CIU 888 parameters in Experion PKS. 

For example, for Product Level (PL) which is a holding register, under 
points in Quick Builder > Add Item>Item Type- Analog point is created 
with name "PL". This is associated to the ANALOG controller and the 
address format is selected based on EPKS standard format (eg: for 32 
signed integer the address format is S32BB, so the PV Source Address 
Part No.: 4417584_Rev04 Configuration Manual
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is configured as ANALOG 27 S32BB. In this example Product Level is 
available at Modbus address 26 in CIU 888).

NOTES: 1. For more information on datatype conversion in Experion PKS, refer to 
Knowledge Builder of Experion PKS.

2. After configuration of all required points, enable configured Modbus channel 
and Modbus controllers in Experion PKS station. 

3. Ensure that the created Server Script engine is in Running state in Experion 
PKS station.
Configuration Manual Part No.: 4417584_Rev04
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APPENDIX D TANK CAPACITY TABLE

Refer to the below table for the Tank Capacity Table format.

Strap File Example Description

[Tank ID] [Tank Identification]

Name = TNK-03 ASCII string: the name of the tank

Date = 15-Feb-15 ASCII string: the date this file is 
generated

Time = 12:34:00 PM ASCII string: the time this file is 
generated

Level = 2 1 = m xxx.xxxx
2 = mm xxxxxx.x
3 = ft xxx.xxxx
4 = in xxxx.xxx
5 = in/16 xxxxxx.x

Volume = 51 50 = l xxxxxxxxx
51 = m3 xxxxxx.xxx
52 = USgal xxxxxxxx.x
53 = bbls xxxxxxx.xx

Ullage = 0 0 = innage
1 = ullage

Straps = 6 Number of straps

[Straps] [Strap data (level vs. volume)]

1 = -233.0 first (and lowest) strap

2 = 100.0

3 = 1006.3

4 = 2001.7 10732.000

5 = 10032.0 52721.000

6 = 20531.4 98321.000 last (and highest) strap

[EOF] [End Of File]
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APPENDIX E CREATION OF NEW MODBUS FIELD DEVICE / TRL/2 FIELD 
DEVICE CONFIGURATION FILE

Based on the Modbus field device / TRL/2 field device manufacturer's 
datasheet, the user shall create the Modbus field device / TRL/2 field 
device configuration file according to the attached Modbus field device 
configuration template.

Refer to the following sections for more information on the Modbus field 
device / TRL/2 field device configuration template.

E.1 Device Type

The following table provides more information on the Device Type.

XML Tag Description Possible Values

<DeviceInformation>
  <DeviceType>

This is the Modbus field device 
type. The user shall provide 
the device type name like 
SLG700, E+H ProServo etc.

Any string

<IsGPUFlexconnValid> This is specific to TRL/2 device 
and not applicable for Modbus 
device. The user can provide 
"TRUE" for Honeywell TRL/2 
devices and "FALSE" for third 
party devices.

TRUE/FALSE

E.2 Device engineering units

The following table provides information on the various engineering 
units supported by the Modbus field device.

XML Tag Description Possible Values

<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <Type>

This specifies the Device unit 
type.

LEVEL
TEMPERATURE
DENSITY
PRESSURE 
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E.3 Valid Register Ranges

The following table indicates the valid consecutive Modbus register 
address ranges in the device.

XML Tag Description Possible Values

<ValidRegisterRanges>
  <Range>
    
<StartRegisterAddress>

This indicates the Modbus 
Start address

300001 to 365535
400001 to 465535

<ValidRegisterRanges>
  <Range>
    <EndRegisterAddress>

This indicates the Modbus End 
address

300001 to 365535
400001 to 465535

E.4 Modbus Map

The following table indicates the Modbus register map of the device that 
can be scanned by CIU.

<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <UnitDetail>
        <UnitName>

This specifies the device 
engineering unit. Refer to 
section E.7 for the supported 
units.

For LEVEL : m, cm, 
mm, ft, yard, in, in/16, 
fis, fii/256, in/256, 
1/10 mm (TRL/2)

For TEMPERATURE : 
°C, °F, K, Tenth 
Fahrenheit (TRL/2), 
Tenth Celsius (TRL/2)

For DENSITY : kg/m³, 
°API, lb/ft³, RD60, lb/ 
US gal, kg/l, gr/ml

For PRESSURE : kgf/
cm², Pa, kPa, psi, atm, 
bar, psi_r100, 
psi_r1000, mBarG 
(TRL/2), mBarA (TRL/
2), 1/100 psiG (TRL/
2), 1/100 psiA (TRL/2)

<DeviceInformation>
  <DeviceUnits>
    <Unit>
      <UnitDetail>
        <Resolution>

This specifies the device 
engineering unit's resolution.

-127 to 128

XML Tag Description Possible Values

<DeviceInformation>
  <ModbusMap>
    <Name>

This indicates the name of 
the parameter in the Modbus 
field device which needs to 
be scanned by CIU.

Any String

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <ModbusRegisterAddress>

This indicates the relative 
Modbus address of a 
parameter in the Modbus 
field device.
Absolute Modbus address of 
Parameter 
                = Device Modbus 
Start Address + Modbus 
Register Address

This is the 6 digit Modbus 
Register address of the 
device parameter. The first 
digit indicates the Modbus 
function code (3 for Input 
registers and 4 for Holding 
registers). Second to Sixth 
digits indicates the Modbus 
register address defined by 
the device manufacturer. 0 
to 65535 registers can be 
addressed. For example to 
address holding register 0 in 
device, 400001 would be set 
here.

300001 to 365535 
400001 to 465535

<DeviceInformation>
  <ModbusMap>
    <NoofModbusRegisters>

This indicates the number of 
Modbus registers defined for 
the selected parameter.

1 to 125

<DeviceInformation>
  <ModbusMap>
    <ModbusDataType>

The data can be exposed in 
different data types by 
different Modbus field 
devices. This parameter 
indicates the Modbus data 
type in which data is 
exposed by the field device 
so that CIU can interpret the 
data accordingly and convert 
it to its internal data format.
Refer to section E.6 for the 
list of supported Modbus 
data types.

Not a number
Fixed number
ASCII string
Unicode string
8-bit unsigned 
integer
8-bit signed integer
16-bit unsigned 
integer
16-bit signed 
integer
16-bit decimal float
12-bit signed 
integer
32-bit signed 
integer
32-
bit float (regular)
32-bit uint/f1
32-bit uint/f10
32-bit uint/f100
32-bit uint/f1000
32-bit uint/f10000

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <ByteOrder>

This indicates the byte (8-
bit) order within a 16-bit 
word in which data is 
exposed by the field device. 
There can be 2 formats in 
which data can be exposed 
(i) LSB first (ii) MSB first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.
Note: This refers the 
endianess of the received 
data at byte level. LSB first 
refer to Little Endian and 
MSB first refers to Big 
Endian.

LSB_First
MSB_First

<DeviceInformation>
  <ModbusMap>
    <WordOrder>

This indicates the word (16-
bit) order within a 32-bit long 
word in which data is 
exposed by the field device. 
There can be 2 formats in 
which data can be exposed 
(i) LSW first (ii) MSW first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.
Note: This indicates the 
endianess of the received 
data at word level. LSW first 
refer to Little Endian and 
MSW first refers to Big 
Endian. 

LSW_First
MSW_First 

<DeviceInformation>
  <ModbusMap>
    <Scaling>

Some Modbus field device 
scales the data it exposes to 
the Modbus host. Hence this 
parameter indicates the 
scaling factor used in the 
exposed data from the field 
device so that CIU can de-
scale the retrieved value.

If Scaling and offset are not 
applicable then this tag can 
be left empty

Any float value

XML Tag Description Possible Values
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<DeviceInformation>
  <ModbusMap>
    <Offset>

Some Modbus field device 
adds an offset to the data it 
exposes to the Modbus host. 
Hence this parameter 
indicates the offset factor 
used in the exposed data 
from the field device so that 
CIU can subtract the offset 
from the retrieved value.

If Scaling and offset are not 
applicable then this tag can 
be left empty

Any 32-bit signed 
value

<DeviceInformation>
  <ModbusMap>
    <ScanPriority>

This indicates the default 
scanning priority for a device 
parameter. This can be 
configured as Foreground / 
Background. While scanning 
the field device, if multiple 
field device parameters are 
retrieved in one Modbus 
request, then highest priority 
within the scanned field 
device parameters is set for 
that request. 
For example, if Product 
Level (Foreground priority), 
Product Temperature 
(Background priority), 
Product Density 
(Background priority) are 
retrieved from the field 
device with a single Modbus 
request, then the Modbus 
request would be scheduled 
to the field with Foreground 
priority.

This can be overridden 
through Modbus Data Input 
configuration in CIU 888 
service tool.

FOREGROUND
BACKGROUND

<DeviceInformation>
  <ModbusMap>
    <DeviceUnitType>

This indicates the device 
unit type of the parameter 
configured in the Modbus 
field device.

If value for this tag is set as 
"ANY" then CIU 888 service 
tool shall display all the 
device supported units in its 
User Interface for this 
parameter in Modbus Data 
Input configuration.

LEVEL
TEMPERATURE
DENSITY
PRESSURE
ANY

XML Tag Description Possible Values
Part No.: 4417584_Rev04 Configuration Manual
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<DeviceInformation>
  <ModbusMap>
    <DeviceUnitName>

This indicates the default 
device unit of the parameter 
configured in the device.

Supported Values are based 
on DeviceUnits section.

For LEVEL : m, 
cm, mm, ft, yard, 
in, in/16, fis, fii/
256, in/256, 1/10 
mm (TRL/2)

For 
TEMPERATURE : 
°C, °F, K
Tenth Fahrenheit 
(TRL/2), Tenth 
Celsius (TRL/2)

For DENSITY : kg/
m³, °API, lb/ft³, 
RD60, lb/ US gal, 
kg/l, gr/ml

For PRESSURE : 
kgf/cm², Pa, kPa, 
psi, atm, bar, 
psi_r100, 
psi_r1000, mBarG 
(TRL/2), mBarA 
(TRL/2), 1/100 
psiG (TRL/2), 
1/100 psiA (TRL/2)

For ANY : The tag 
shall be empty

XML Tag Description Possible Values
Configuration Manual Part No.: 4417584_Rev04
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<DeviceInformation>
  <ModbusMap>
    <FailedValue>

This indicates Modbus field 
device parameter failure 
value. That is, when 
parameter value retrieved 
from Modbus field device is 
equal to this value, it 
indicates the device 
parameter value is in failure. 
For example, if 
0xFFFFFFFF represents 
Product level measurement 
failure for a Modbus field 
device, then when CIU 
receives that value it 
interprets that the Product 
level measurement has 
failed and sets the Product 
Level status accordingly.

When status register is 
present in the device (Status 
tag information present), 
status and validity of the 
device parameter would be 
determined by CIU based on 
Status tag in the status 
section and this tag shall be 
empty.

Any HEX string as 
per the Modbus 
field device 
manufacturer.

<DeviceInformation>
  <ModbusMap>
    <Status>
      <Name>

This is the device status 
parameter name as defined 
in the Manufacturer's 
product data sheet.

Any string

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ModbusRegisterAddress>

This indicates the Modbus 
register address of the 
status parameter associated 
with device parameter that 
needs to be scanned by CIU 
888.

This is the 6 digit Modbus 
Register address of the 
device parameter. The first 
digit indicates the Modbus 
function code (3 for Input 
registers and 4 for Holding 
registers). Second to Sixth 
digits indicates the Modbus 
register address defined by 
the device manufacturer. 0 
to 65535 registers can be 
addressed. For example to 
address holding register 0 in 
device, 400001 would be set 
here.

300001 to 365535 
400001 to 465535

XML Tag Description Possible Values
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E.5 Custom Value Map

This configuration defines the value mapping between device 
parameter value and CIU parameter value. This configuration would be 
defined only if a direct mapping of device parameter value to CIU 

<DeviceInformation>
  <ModbusMap>
    <Status>
      < NoofModbusRegisters >

This indicates the number of 
Modbus registers defined for 
the Modbus field device 
status parameter that needs 
to be scanned by CIU 888.

As per Modbus 
field device 
Modbus datasheet

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ModbusDataType>

This indicates the Modbus 
datatype for the Modbus 
field device status parameter 
that needs to be scanned by 
CIU 888.

Not a number
Fixed number
8-bit unsigned 
integer
8-bit signed integer
16-bit unsigned 
integer
16-bit signed 
integer
12-bit signed 
integer
32-bit signed 
integer

<DeviceInformation>
  <ModbusMap>
    <Status>
      <ByteOrder>

This indicates the Modbus 
field device's byte order for 
16 bit status data. Based on 
this configuration, CIU 888 
inteprets the field device 
status value with correct 
byte ordering.
There can be 2 formats in 
which data can be exposed 
(i) LSB first (ii) MSB first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.

LSB_First
MSB_First

<DeviceInformation>
  <ModbusMap>
    <Status>
      <WordOrder>

This indicates the Modbus 
field device's word order for 
32 bit status data. Based on 
this configuration, CIU 888 
interprets the field device 
status value with correct 
word ordering.
There can be 2 formats in 
which data can be exposed 
(i) LSW first (ii) MSW first. 
Based on this configuration 
CIU interprets the data and 
converts it to its internal data 
format.

LSW_First
MSW_First

XML Tag Description Possible Values
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parameter value is not possible. For example, Product level value in 
device can be directly mapped to CIU Product level value but Gauge 
status / Gauge alarms from the device might not directly map to CIU 
Gauge status / Gauge alarms and needs a custom value map. Refer to 
the following table for more information.

XML Tag Description Possible Values

<CustomValueMap>
  <CustomValue>
    <DeviceParameterName>

This is the device parameter 
name as defined in the 
Manufacturer's product data 
sheet to which we need to 
associate the custom value.

Any value defined as 
part of 
<DeviceInformation><
ModbusMap>
 <Name> (or) 
<DeviceInformation><
ModbusMap>
<Status><Name>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <Name>

This indicates the CIU 
Parameter Name to which 
device parameter is mapped.

ProductLevelStatus
ProductTempStatus
WaterMeasuredStatus
DObsHIMSStatus
VapRoomTempStatus
VapRoomPressStatus
AmbientTemperature
Status
GaugeStatus
GaugeLevelAlarms
ExternalContacts

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <ValueMapType>

This indicates the value map 
type.
Device parameter's 
enumeration to CIU 
parameter's enumeration shall 
be specified here.

EnumerationToEnume
ration

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DefaultValue>

Default Value indicates what 
should be the CIU value if 
EnumerationToEnumeration is 
selected for ValueMapType 
and no mapping defined for a 
particular device parameter 
value

Any value as per CIU 
parameter

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DeviceParameterStartBitIndex>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <DeviceParameterEndBitIndex>

This value indicates the 
portion of the device value 
which needs to be copied to 
the CIU parameter.

For example, if Bits 15 to 8 of 
the device parameter needs to 
be copied then BitM = 8 and 
BitN = 15.

If the entire device value 
needs to be copied then this 
tag shall be empty

Any value as per 
Modbus field device 
Modbus datasheet
Part No.: 4417584_Rev04 Configuration Manual
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E.6 Supported Modbus Data types

Modbus Data types are not standard. Based on the analysis of the 
Modbus field devices, the following Modbus data types would be 
supported in CIU.

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <CIUParameterStartBitIndex>

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <CIUParameterEndBitIndex>

This value indicates the 
portion in the CIU parameter 
where the device value needs 
to be copied.

For example, if the device 
value needs to copied to Bits 
12 to Bit 8 after value mapping 
is done then it BitM = 8 and 
BitN = 12

If the the device value (after 
value mapping) needs to 
completely replace CIU 
parameter value then this tag 
shall be empty.

Any value as per 
Modbus field device 
Modbus datasheet

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <MapDetail>
        <DeviceParameterValue>

Device Value in Modbus data 
type.

Any value as per 
Modbus field device 
Modbus datasheet

<CustomValueMap>
  <CustomValue>
    <CIUMapDetail>
      <MapDetail>
        <CIUParameterValue>

CIU Value in CIU Parameter 
data type.

Any value as per CIU 
parameter

Modbus Data 
Type

Description

Not a number This data represents 8 / 16 bit coded information.

Fixed number This data represents a 16 bit fixed number. 

ASCII string The data represents a string of two ASCII characters per 
register.

Unicode string The data represents a string of one UNICODE character per 
register

16-bit unsigned 
integer

The data represents an unsigned integer.
Range : 0 to 65535

16-bit signed 
integer

The data represents an signed integer (in 2’s complement).
Range : -32768 to 32767

XML Tag Description Possible Values
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16-bit decimal 
float

Bit 15       : sign
Bit 14..11 : Exponent power of 10
Bit 10..0   : Mantissa

Value = -1 sign * mantissa * 10 (Exponent - 7)

Range : -1023*E7 to +1023*E7

12-bit signed 
integer

Bit 15..13 : Not used
Bit 12       : 0 – Positive
                  1 – Negative
Bit 11..00 : Value 0 to 4095.

If the sign is negative, the value is shown in 2’s complement.

Range : -4095 to +4095

32-bit signed 
integer

The data represents an signed integer.
Range : + 2147483648 to – 2147483647

32-
bit float (regular)

32 Bit IEEE floating point in TWO registers.
All floating point data is coded into 4 Bytes Floating point.
This format allows a representation of finite numbers from 
negative to positive 3.402823 *E38

Range : -3.402823*E-38 to +3.402823*E38

32-bit uint/f1 Most significant 16 bits represent integer data and least 
significant 16 bits is 0.

Range : 0 to 65535.5

32-bit uint/f10 Most significant 16 bits represent integer data and least 
significant 16 bits represents 1 fraction digit.

Range :  0...65535.95

32-bit uint/f100 Most significant 16 bits represent integer data and least 
significant 16 bits represents 2 fraction digits.

Range : 0...65535.995

32-bit uint/f1000 Most significant 16 bits represent integer data and least 
significant 16 bits represents 3 fraction digits.

Range : 0...65535.9995

32-bit uint/
f10000

Most significant 16 bits represent integer data and least 
significant 16 bits represents 4 fraction digits.

Range : 0...65535.99995

Char This data represents an ASCII character.

8-bit signed 
integer

This data represents an 8-bit signed data.

Range : -127 to 128

Modbus Data 
Type

Description
Part No.: 4417584_Rev04 Configuration Manual
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E.7 Supported Device Engineering Units

Device engineering units are not standard. Based on the analysis of the 
Modbus field devices, the following device engineering units would be 
supported in CIU.

8-bit unsigned 
integer

This data represents an 8-bit unsigned data.

Range : 0 to 255

Units of 
Measurement 
Type

Device Unit

Level Meters

Millimeters

Tenth Millimeter (TRL/2)

Feet

Inches

Sixteenth of Inch

TwoFiftySixth of inch

Centimeter

Yard

Temperature Celsius

Tenth Celsius

Tenth Fahrenheit

Fahrenheit

Kelvin

Pressure KGF CM SQ

Pascal

Kilo Pascal

PSI

ATM

Bar

mBarG (TRL/2)

mBarA (TRL/2)

1/100 psiG (TRL/2)

1/100 psiA (TRL/2)

PSI RANGE 100

PSI RANGE 1000

Modbus Data 
Type

Description
Configuration Manual Part No.: 4417584_Rev04
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Density Kilogram cubic meters

Degrees API

Pounds cubic feet

RD60

lbs_us_gallon

kilogram_liters

Gram / Millilitre

Units of 
Measurement 
Type

Device Unit
Part No.: 4417584_Rev04 Configuration Manual
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Appendix F - List of Abbreviations
APPENDIX F LIST OF ABBREVIATIONS

Abbreviation Description

BPM Bi-Phase Mark

CIU Communication Interface Unit

DCS Distributed Control System

GOV Gross Observed Volume

GPU Gauge Processing Unit

GSV Gross Standard Volume

HTTP Hypertext Transfer Protocol

PC Personal Computer

PLC Programmable Logic Controller

RAM Random Access Memory

RTU Remote Terminal Unit

SCADA Supervisory Control And Data Acquisition

TOV Total Observed Volume

TRL Tank Radar Level

W&M Weights and Measures

XML Extensible Markup Language
Part No.: 4417584_Rev04 Configuration Manual
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